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Copyright and Trademark Notice

Thecus and other names of Thecus products are registered trademarks of Thecus
Technology Corp. Microsoft, Windows, and the Windows logo are registered
trademarks of Microsoft Corporation. Apple, iTunes and Apple OS X are registered
trademarks of Apple Computers, Inc. All other trademarks and brand names are
the property of their respective owners. Specifications are subject to change
without notice.

Copyright © 2007 Thecus Technology Corporation. All rights reserved.

About This Manual

All information in this manual has been carefully verified to ensure its correctness.
In case of an error, please provide us with your feedback. Thecus Technology
Corporation reserves the right to modify the contents of this manual without
notice.

Product name: Thecus N299
Manual Version: 1.1.1
Release Date: August 2008

Limited Warranty

Thecus Technology Corporation guarantees all components of Thecus N299 are
thoroughly tested before they leave the factory and should function normally
under general usage. In case of any system malfunctions, Thecus Technology
Corporation and its local representatives and dealers are responsible for repair
without cost to the customer if the product fails within the warranty period and
under normal usage. Thecus Technology Corporation is not responsible for any
damage or loss of data deemed to be caused by its products. It is highly
recommended that users conduct necessary back-up practices.



Safety Warnings

For your safety, please read and follow the following safety warnings:

Read this manual thoroughly before attempting to set up your N299.

* Your N299 is a complicated electronic device. DO NOT attempt to repair it

under any circumstances. In the case of malfunction, turn off the power
immediately and have it repaired at a qualified service center. Contact
your vendor for details.

» DO NOT allow anything to rest on the power cord and DO NOT place the

power cord in an area where it can be stepped on. Carefully place
connecting cables to avoid stepping or tripping on them.

* Your N299 can operate normally under temperatures between 5°C and

40°C, with relative humidity of 0% — 80%. Using the N299 under extreme
environmental conditions could damage the unit.

* Ensure that the N299 is provided with the correct supply voltage (AC 100V

~ 240V, 50/60 Hz). Plugging the N299 to an incorrect power source could
damage the unit.

* Do NOT expose the N299 to dampness, dust, or corrosive liquids.
* Do NOT place the N299 on any uneven surfaces.

* DO NOT place the N299 in direct sunlight or expose it to other heat

sources.

* DO NOT use chemicals or aerosols to clean the N299. Unplug the power

cord and all connected cables before cleaning.

* DO NOT place any objects on the N299 or obstruct its ventilation slots to

avoid overheating the unit.

» Keep packaging out of the reach of children.

» If disposing of the device, please follow your local regulations for the safe

disposal of electronic products to protect the environment.
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Chapter 1: Introduction

Overview

Thank you for choosing the Thecus N299 IP Storage Server. The Thecus N299 is
an easy-to-use storage server that allows a dedicated approach to storing and
distributing data on a network. Data reliability is ensured with RAID features that
provide data security and recovery. Two Gigabit Ethernet ports enhance network
efficiency, allowing the N299 to take over file management functions. The N299’s
user-friendly GUI supports multiple languages, and its built-in media server and
optional wireless connectivity via USB dongles allow users to share and enjoy
their digital media in virtually any room of the house.

Product Highlights

File Server

First and foremost, the N299 allows you to store and share files over an IP
network. With a Network Attached Storage (NAS) device, you can centralize your
files and share them easily over your network. With the easy-to-use web-based
interface, users on your network can access these files in a snap.

To learn about the Web User Interface, go to Chapter 5: Using the N299 >
Web User Interface.

Media Server

The N299 can also act as a convenient media server, allowing you to enjoy and
share photos, music, and movies via the uPnP AV streaming protocol.

To set up the Media Server, refer to Chapter 4: Additional Feature Setup >
Media Server.

FTP Server

With the built-in FTP Server, friends, clients, and customers can upload and
download files to your N299 over the Internet with their favorite FTP programs.
You can create user accounts so that only authorized users have access.

To set up the FTP Server, refer to Chapter 4: Additional Feature Setup > FTP
Server.

iTunes® Server

Digital music is one of the hottest trends, and with the built-in iTunes® server,
you can share your digital music files with every iTunes-equipped PC on your
network. The iTunes Server is also incredibly easy to set up!

To set up the iTunes Server, refer to Chapter 4: Additional Feature Setup >
iTunes Server.

Photo Gallery

Got a lot of photos? Share them effortlessly with the N299’s built-in Photo Gallery.
Users can create albums and upload photos in a snap, and the N299 will even
auto-create thumbnails.

To find out how to share photos with the N299, refer to Chapter 5: Using the
N299 > Using Photo Gallery.
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Backup Server

Don’t leave precious data to chance. With advanced backup capabilities, you can
easily upload mission critical files to the N299, and even automate your backup
tasks for true peace-of-mind.

To find out how to backup your files with the N299, refer to Chapter 5: Using
the N299 = File Backup.

Download Manager

Tired having downloads take up all of your bandwidth when you need it most?
With the N299’s Download Manager, you can let the N299 complete your BT,
HTTP, and FTP during off-peak hours. With the N299 lower power requirements,
you can even save money off your monthly power bill.

To set up the Download Station, refer to Chapter 4: Additional Feature Setup
> Download Manager.

Printer Server

With the N299’s Printer Server, you can easily share an IPP printer with other PCs
connected to your network.

To set up the Printer Server, refer to Chapter 4: Additional Feature Setup >
Printer Server.

IP Cam Surveillence Server

Keep an eye on things with the built-in IP Cam Surveillence Server. Just plug in a
compatible webcam and the N299 can send snapshots to an account that you
specify. Best of all, your PC doesn’t even have to be turned on!

To set up the IP Cam Surveillence Server, refer to Chapter 4: Additional
Feature Setup > IP Cam Surveillence.

Package Contents
Your N299 package should contain the following items:

® Thecus N299 NAS Device

® Accessory Pack:

Power cord

RJ-45 Ethernet cable
hard disk screws

hard disk tray screws
Installation CD

Quick Installation Guide
Warranty card

O O0OO0OO0OO0OO0Oo

Please check to see if your package is complete. If you find that some items are
missing, contact your dealer.



Front Panel

Power One-Button Copy

USB

The N299’s front panel displays the unit’s array of status LEDs, and is also where
you’ll find the power button and USB port. See the table below for a detailed
explanation of each:

Item Description

Power LED e Solid blue: N299 is powered on

System Status LED Blinking orange: system is starting up
Blinking red: system error
Off: system startup complete; system operating normally

HDD1 LED Solid blue: HDD 1 detected

Blinking blue: Active HDD 1 data transfer

Solid red : HDD 1 error detected

Blinking red: HDD 1 capacity is nearly full (90% or more)
If RAID is configured, capacity is based on the entire RAID

system.

* ¢ ¢ o o (06 o o

HDD2 LED Solid blue: HDD 2 detected

Blinking blue: Active HDD 2 data transfer

Solid red : HDD 2 error detected

Blinking red: HDD 2 capacity is nearly full (90% or more)
If RAID is configured, capacity is based on the entire RAID

system.

+ ®© © @ @

One-Button USB e One-Button Copy

Copy Push once to copy entire USB volume to the N299. A short
beep will sound to acknowledge that files are now being
copied. Files are stored in a folder named by current time
stamp: (YearMonthDayHHMM)

WAN LED

Solid green: network link
Blinking green: network activity

LAN LED Solid green: network link

Blinking green: network activity

USB LED USB Device Connection
o Blinking blue (5 seconds): USB device connected
successfully.
*For universal USB memory card readers, the USB LED
will blink blue when one or more card is mounted

successfully.
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o Blinking red (5 seconds): USB device connection failure
e Data Transfer

o Blinking blue: Active data transfer

o Blinking red: USB device read/write error

USB Port e USB 2.0 port for USB storage expansion.
Power Button e Power on/off N299
Rear Panel

usB1USB2 J|{ Wan (up) Lan (down)

Power Connector Fan

The rear panel of the N299 houses the USB and Ethernet connections, as well as
the power connector. See the table below for descriptions of each:

Item Description

Power Connector e Connect the included power cord to this connector

WAN Port e WAN port for connecting to an Ethernet network through a
switch or router

LAN Port e LAN port for connecting to an Ethernet network through a switch
or router

USB Ports .‘I} e USB 2.0 ports for storage expansion

There are two USB ports at the back panel
NOTE of N299, you can use either one, but not
two at the same time.
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Chapter 2: Getting Started

Overview

Your N299 is designed for complete ease-of-use. To help you get started, the
following chapter will help you get your N299 up and running in no time. Please
read it carefully to prevent damaging your unit during installation.

Before You Begin
Before you begin, be sure to take the following precautions:

1. Read and understand the Safety Warnings outlined in the beginning of
the manual.

2. If possible, wear an anti-static wrist strap during installation to prevent
static discharge from damaging the sensitive electronic components on the
N299.

3. Be careful not to use magnetized screwdrivers around the N299’s
electronic components.

4. The N299 uses its chassis to dissipate heat. Please leave your N299 in a
well-ventilated area to prevent overheating.

Hard Disk Installation

The N299 supports standard 3.5” (SATA) hard disks. To install a hard disk into
the N299, follow the steps below:

1. Remove two screws located on the back of the unit using a Philips
screwdriver.

2. Unscrew four mounting screws.
3. Lift up the hard disk tray by pulling up the top panel of the N299.

4. Carefully insert a standard 3.5” SATA hard disk into the tray, and secure
the hard disk with screws from the included accessory pack.

5. If you are installing two hard disks, please insert the second hard disk at
the bottom of the tray and secure it with screws from the included
accessory pack.

6. Carefully lower the hard disk tray back into the N299.

7. After making sure the tray is in place and the connectors are aligned,
secure the hard disk tray with screws.

If your hard disk was previously part of a RAID 1 array, it will automatically rebuild.
NOTE If you replace all the drives with higher capacity drives, you need to go to the
Administrator login and format the drives.

12



Cable Connections
Make the following connections on the Thecus N299 and then power up the unit:

1.

Connect an Ethernet cable from your network to the WAN port on the
back panel of the N299.

Connect the provided power cord into the universal power socket on the
back panel. Plug the other end of the cord into a surge protected socket.

Press the power button on the front panel to power on the N299.

Make sure system is running properly by checking all front panel LEDs for
any error indications.

Installation Wizard

The handy Thecus Setup Wizard makes configuring N299 a snap. To configure the
N299 using the Setup Wizard, perform the following steps:

1.

3.

Insert the installation CD into your CD-ROM drive (the host PC must be
connected to the network).

The Setup Wizard should launch automatically. If not, please browse your
CD-ROM drive and double click on Setup.exe.

NOTE For MAC OS X users, double click on Thecus Setup Wizard 1.1.6.dmg }

Complete the Setup Wizard

a. Device Discovery

The Setup Wizard will start and automatically detect all Thecus Storage
devices on your network.
Thecus Setup Wizard

Device Discovery Version 1.1.96
@ Device Mo HostMame | IP | MAC A
Discovery
1721666119 00-50-80-30-FF-B2
& Login
System
& Network

Configuration

& Enable
Service

& Hard Disks
Setup

(=

& Change
Password

& Complete

13



b. Login
Login into N299 with administrator’s account and password.

Thecus Setap Wizard

-

IP Storage Appliance

Login System Version 1.1.96

& Device
Dizcovery

‘ Login
Syztem

@ Network
Configuration

‘& Enable
Service

& Hard Disks
Setup

‘& Change
Pas sword

& Comelets JPREV T | NEXT | END

c. Network Setting
Name your N299 system and configure the network IP address. You

can choose either fixed IP or DHCP.
Thecus Setup Wizard

~

Network Configuration Version 1.1.96
] D!:wice HostMName |N29ﬂ
Discovery
& Login
System
172.16.66.119
’ MNetwork

Configuration 255.255.255.0

172.16.66.135

# Change 5 172.16.66.244
Pas sword :

& Complete
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d. Change Admin Password
Thecus Setap Wizard

IP Storage Appliance

Change Password Version 1.1.96

& Device
Dizcovery

& Login
Syztem

‘& Network
Configuration

@& Change
Pas sword

@ Complste PREV T | APPLY | TEND

e. Start Browser
Access the current N299 administrator Web User Interface pressing the

“Start Browser” button.

Thecus Setnp Wizard
-

IP Storage Appliance

comPIEle Wersion 1.1.95

& Device
Discovery

& Login
Swyztem

& Network

Configuration
I talmwser

& Change
Password

® Complas [SEND
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f. RAID and FW installation
Please config the RAID first then carry on with FW installation to
complete setup procedure.

Status
Storage

RAID Configuration |

sy I RAID Level JEOD - RAIDD  RAID 1
Network | Disk No.  Capacity (MB) = Model  Status RAID
Accounts 1 783648 ST3I300831AS  OK
system 2 | 283848 ST3300831AS  OK

Language Stripe Size oo ilo Syies

\Create RAID  Crzaie | Remove RAID

Status
Storage
Network
Accounts
System

rmware Upgrade

Firmware [

Language

The Thecus Setup Wizard is designed for installation on systems running Windows
XP/2000 or Mac OSX or later. Users with other operating systems will need to install
the Thecus Setup Wizard on a host machine with one of these operating systems
before using the unit.

16



First Time Setup

Once the hardware is installed, physically connected to your network, and
powered on, you can now configure the Thecus N299 so that it is accessible to
your network users. Follow the steps below for initial software setup.

Step 1: Initial Login
Make sure your network is connected to the Internet and access the N299 Login

webpage:

1. Type in the default IP address http://192.168.1.100 in your browser’s
address line. If you have changed the N299’s IP address, type this in
instead.

To access any IP address, your computer must be configured with the correct IP
NOTE settings. The IP address should be 192.168.1.x, where X is a number between 1 and
254.

2. The Login screen appears.

3. To gain initial access to the system type in the factory default
administrator user name and password, which are as follows:

User Name: admin
Password: admin

4. Press Login.

5. The About screen from the Status menu appears showing product
information.

Step 2: System Check and Configuration

Once logged in, you are greeted with the Web Administration Interface, where
you can check the N299’s status, as well as configure its operating parameters.

1. In the Status menu, choose the System item to go to the System
Status screen. Check that the basic system information such as CPU
loading and Fan RPM are all OK.

2. In the Status menu, choose the Info item to go to the System
Information screen. Change the System Description to describe your
system and press Apply. This information appears on the Login page.

3. In the System menu, choose the Administrator Password item. The
screen that appears lets you change the administrator password for the
system. Press Apply to confirm your settings.

4. In the System menu, choose the Time item and the Time screen appears.
Set the date, time and time zone and press Apply.

Step 3: Configure Network Settings

After setting the N299’s basic configuration options, the next step is to configure
its network settings.

1. In the Network menu, choose the WAN item and the Network
Configuration screen appears.

17



2. Set host name and specify the domain name.

3. Enable DHCP for setting the IP automatically or Disable DHCP to enter
your own IP settings.

4. Repeat steps 2 and 3 for the LAN item under the Network menu to
configure the LAN port.

5. In the Network menu, choose the Service item and the Service
Support screen appears.

6. Enable or Disable each protocol according to your requirements. Press
Apply to confirm the setting.

= For normal usage, enabling all protocols is recommended.

= For added security, disable WebDisk support and enable Secure WebDisk
support.

= |If DHCP is enabled in the Network Settings screen, UPnP is automatically
enabled.

For details on configuring your network settings, refer to Chapter 3: System
Management > Network Management.

Step 4: Select RAID Level

Once the network is configured, you should then select the appropriate RAID level
and build your RAID array.

1. From the Storage menu choose RAID item and the RAID Information
screen appears. Press the Config button and the RAID Configuration
screen appears.

2. Select your desired RAID mode.

If security is your primary concern, for 2 disks, choose RAID 1. If capacity is your
NOTE primary concern, choose JBOD or RAID 0. See Appendix C for more information.

3. Check the hard disks you wish to create a RAID on. Specify a stripe size—
64K is a normal setting.

4. Press the Create button to build the RAID storage volume. Configuring
RAID is usually only required for initial setup.

Building a RAID storage space may take time, depending on the size of hard drives
NOTE and RAID mode.

Step 5: Create Local Users and Groups

After your RAID is built, you can begin to create local users and groups for the
N299.

1. From the Accounts menu, choose Users item and the Local User
Configuration screen appears. Click Add to add a new user.

2. Enter a name and password for each user in the Name and Password
boxes and re-enter the password in the Confirm Password box.

18



3. Press the Apply button for each user and they will be added to the user
list.

4. From the Accounts menu, choose Groups item and the Local Group
Configuration screen appears. Click Add to add a new group.

5. Enter a group name in the Group Name box and click Apply to add the
group to the group list.

For more on managing users, go to Chapter 3: System Management > User
and Group Management.

Step 6: Create Folders and Set Up ACLs

Once users are introduced into your network, you can begin to create various
folders on the N299 and control user access to each using Folder Access Control
Lists.

1. From the Storage menu, choose the Folder item and the Folder screen
appears. Press the Add button and the Add Folder screen appears.

2. Enter the name and description of the folder and choose whether it is
browseable. Press Apply to create the folder.

3. On the Folder screen press ACL (Access Control List) to configure which
users have access to this folder.

4. On this screen, configure access to this folder for users and groups. Select
a user or a group from the left hand column and then choose Deny
Access, Read Only, or Writable to configure their access level. Press
Apply to confirm settings.

You must set the ACL for each folder for access by specific users and groups;
NOTE otherwise the folder is inaccessible to all users and groups

For more information on managing folders, see Chapter 3: System
Management > Storage Management > Folder Management.

To find out about configuring Folder Access Control Lists, see Chapter 3: System
Management > Storage Management > Folder Management > Folder
Access Control List (ACL).

Step 7: Start Services

Finally, you can start to setup the different services of the N299 for the users on
your network. You can find out more about each of these services by clicking
below:

Windows Networking Media Server

Apple File Protocol (AFP) Download Manager

FTP Server Printer Server

iTunes® Server IP Cam Surveillance Server

Photo Gallery
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Chapter 3: System Configuration

Overview

The N299 provides an easily accessible web management interface. With it, you
can configure and monitor the N299 anywhere on the network.

Web Administration Interface

Make sure your network is connected to the Internet. To access the N299 Login
Page:

1. Type the N299’s IP address into your browser. (Default IP address is
http://192.168.1.100)

mis)  N299

Tiogn
@ our 10 | Password: | (Cogn]

Th i M AVE R
Your computer’s network IP address must be on the same subnet as the N299. If
NOTE the N299 has default IP address of 192.168.1.100, your managing PC IP address
must be 192.168.1.x, where x is a number between 1 and 254, but not 100.

2. Login to the system using the administrator user name and password. The
factory defaults are:

User Name: admin
Password: admin

If you changed your password in the setup wizard, use the new password.

Once you are logged in as an administrator, you will see the Web
Administration Interface. From here, you can configure and monitor virtually
every aspect of the N299 from anywhere on the network.

Menu Bar

The Menu Bar is where you will find all of the information screens and system
settings of the N299. The various settings are placed in the following groups on
the menu bar:

Item Description

Status Current system status of the N299.

Storage Information and settings for storage devices installed into the
N299.

Network Information and settings for network connections and services,
as well as various services of the N299.

Accounts Allows configuration of users and groups.

System Various N299 system settings and information.

Language Choose your preferred language here.
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Clicking on any of these items will display the dropdown menu selections for each
group.

In the following sections, you will find detailed explanations of each function, and
how to configure your N299.

Language Selection

The N299 supports multiple languages. On the menu bar, click Language and
the Change Language screen appears. This screen allows you to select
preferred language for the N299. The N299’s interface supports the following
languages: - -

English

Simplified Chinese
Traditional Chinese
German

French

Italian

Japanese

Korean

Spanish

Press Apply to confirm your
selection.

Language Package Upload and Management

You can also upload additional language packs as they become available. To do
this, press Upload and the Language Package Upload/Management and
User Upload Language Package List screens appear.

To upload a language package, click Browse and browse for the language
package location. Select the language package file and click Open. Then, click
Apply to upload the language package to the N299. Once uploaded, the language
package will appear in the User Upload Language Package List.

User Upload Language Package List

Item Description

Product Name of language package.

Version Language package version number.

Description Language package description.

Remove Package Click Remove to remove the selected language package.
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Status Menu

The Status Menu on the menu bar allows you to see various aspects of the N299.
From here, you can discover the status of the N299, and even find out other
details like firmware version and up time.

Product Information

Once you login, you will first see the
basic Product Information screen
providing Manufacturer, Product
No., Firmware Version, and Up
Time information.

To access this screen again, navigate
to Status > About.

Up Time 0 days, 13 hours, 3 minules

System Status

From the Status menu, choose the
System item, and the System
Status screen appears. This screen
provides basic system status
information.

CEU Laadirs) 13%
FasRPM 033REN
Faa Spoml Contiol @ Haimal ) High
Up Thoa 0 days, 14 houis, T minutes

L |

System Status

Item Description

CPU Loading (%) Displays current CPU workload of the N299.

Fan RPM Displays current RPM of the internal fan.

Fan Speed Control You may select a desired fan speed from here. Normal and
High fan speeds are available. Click Apply to save your
changes.

Up Time Shows how long the system has been running.
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System Information

From Status menu, choose the Info
item, and the System Information
screen appears. You can change the
system information that appears on
uPnP devices screens (i.e. Network . .
Neighborhood) on Windows-based oy | e a1
systems by entering the new | i | ] |
information here and pressing Apply =
to confirm.

System Information

Item Description
System Description Shows the system description that would also appear on the
Login page.

Printer Status

In order to use the Printer Server, you must first install the Printer Server module
located on the installation CD. Once installed, the Printer Status option will appear
on the Main Menu. See Chapter 4: Additional Feature Setup > Print Server for more
details.

From the Status menu, choose the Printer item, and the Printer Information
screen appears. The Printer Information screen provides the following information
about the USB printer connected to the USB port.

Printer Information

Item Description

Manufacturer Displays the name of the USB printer manufacturer.
Model Displays the model of the USB printer.

Status Displays the status of the USB printer.

Printer Queue Click to remove all documents from printer queue

If a corrupt print job is sent to a printer, printing may suddenly fail. If your print
jobs seem to be locked up, pressing the Remove All Documents button to clear
the print queue may resolve the issue.

For information on how to set up the Printer Server, refer to Chapter 4:
Additional Feature Setup > Printer Server.
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Storage Management

The Storage Menu displays the status of storage devices installed or connected
to the N299, including disk and RAID information.

Disk Information

From the Storage menu, choose the
Disks item and the Disk
Information screen appears. From
here, you can see various items
about installed SATA hard disks. " i e U s
Blank lines indicate that a SATA hard [ | I et bl e

disk is not currently installed in that =
particular disk slot.

SATA Information

Item Description

Disk Slot Indicates disk location.

Capacity (MB) Shows the SATA hard disk capacity.

Model Displays the SATA hard disk model name.

Firmware Shows the SATA hard disk firmware version.

Status Indicates the status of the disk. Can read OK, Warning, or Failed.
Total Shows the total SATA hard disk capacity.

File System Check | Click Apply to run a file system check on installed hard disks.

Some services will scan the content directories, and this will keep the hard disk
NOTE drive from spinning down.

RAID Information

From the Storage menu, choose the
RAID item and the RAID
Information screen appears.

AR Loval RAID D
Tatal Capaciny 453251MB
Statmy Heatitry

sl Pascastago ANBI%)
Sdrlpe Size B Vilo Brles
Ratnaining Time Hia,

RAID Information

Item Description

RAID Level Shows the current RAID configuration.

Total Capacity Shows total capacity of the RAID configuration.

Status Indicates status of the RAID. Can read either Healthy or Failed.
Used Percentage Displays percentage of used RAID capacity.

Stripe Size Shows the current disk stripe size.

Remaining Time Indicates time remaining until the RAID is finished building.

To configure your RAID settings, press the Config button to go to the RAID
Configuration screen.
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RAID Configuration

On the RAID Information screen,
press the Config button to go to the
RAID Configuration screen. In
addition to RAID disk information and
status, this screen lets you make .
RAID configuration settings. e ! — TR

sk o, Capaclly (ME) el Stalws FAM
1 FLSEY ATHI0ERIAE ai
2 TIEE WO WDRIOJC-DOLEAD 0K

For more information on RAID, see

SArips Size (L2 )

Appendix C: RAID Basics. - eser Ao 20 [ |
- ===l

RAID Level

You can set the storage volume as either None, JBOD, RAID O, or RAID 1.
RAID configuration is usually required only when you first set up the device. A
brief description of each RAID setting follows:

RAID Levels

Level Description

None There is no existing storage volume.

JBOD The storage volume is a single HDD with no RAID support. JBOD
requires a minimum of 1 disk.

RAID O Provides data striping but no redundancy. Improves
performance but not data safety. RAID O requires a minimum of
2 disks.

RAID 1 Offers disk mirroring. Provides twice the read rate of single
disks, but same write rate. RAID 1 requires a minimum of 2
disks.

If the administrator improperly removes a hard disk that should not be removed
WARN I NG when RAID status is degraded, all data will be lost.

Disk Settings

Using Disk Settings, you can select stripe size, choose which disks are RAID
disks.

Disk Settings

Item Description

RAID Check the boxes of the hard drives you wish to add to the
storage volume.

Stripe Size This sets the stripe size to maximize performance of sequential

files in a storage volume. Keep the 64K setting unless you
require a special file storage layout in the storage volume. A
larger stripe size is better for large files.

Create RAID Press this button to configure a file system and create the RAID
storage volume.
Remove Click to remove the RAID volume. All user data, snapshot, and

Target USB data will be removed.
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Creating a RAID
To create a RAID volume, follow the steps below:

1. On the RAID Configuration screen, set the RAID storage space as JBOD,
RAID O, or RAID 1 — see Appendix C: RAID Basics for a detailed
description of each.

Tick the checkboxes of the hard disks you wish to use to create a RAID.
Specify a stripe size — 64K is the default setting.

Press Create to build the RAID storage volume.

PON

NOTE and RAID mode.

Building a RAID storage space may take time, depending on the size of hard drives J

WAR N I NG Creating RAID destroys all data in the current RAID. The data is unrecoverable. ]

Deleting a RAID
To delete a RAID volume, follow the steps below:

1. On the RAID Configuration screen, click Remove.
2. The system automatically removes the RAID volume and you can create a
new RAID.

WAR N l N G Removing RAID destroys all data in the current RAID. The data is unrecoverable. ]

Folder Management

From the Storage menu, choose
Folder, and the Folder screen

appears. This screen allows you to i
Fabden Mame Descripties REs AL Edll Remove

create and configure folders on the L  [EEmEr
N299 V0|Ume. i Tnancial datnt.

Item Description

Folder nhame Displays the name of the folder.

Description Provides a description of the folder.

NFS Press NFS to setup access privilege.

ACL Press ACL (Access Control List) to configure which users have
access to this folder.

Edit Press Edit to enter the Edit screen and modify the folder’s
name and description.

Del Press Del to delete the folder. A screen appears asking to
confirm the deletion.

Remove Press Remove to delete folder.

Add Press Add to enter the Add Folder screen.
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Adding Folders

On the Folder screen, press the Add
button and the Add Folder screen
appears. This screen allows you to
add a folder. After entering the
information, press Apply to create
new folder. Press Back to return to

the Folder screen.

Fedden Blama |

Dascrigtion |

nuwn.\mn'@m £ he
Public (3 Yas @ Ha

Wab hocass (3 Fes 5 o

T L

Add Folder

Item Description

Folder Name Enter the name of the folder.

Description Provide a description the folder.
Browseable Enable users to browse the folder content.
Public Admit or deny public access to this folder.
Web Access Admin or deny access through web disk.
Apply Press Apply to create the folder.

Reset Press Reset to clear entered data.

NOTE

Folder names are limited to 60 characters. Systems running Windows 98 or earlier
may not support file names longer than 15 characters.

Editing Folders

On the Folder screen, press the Edit r ol
button and the Edit Folder screen =
appears. This screen allows you to
change folder information. After
entering the information, press
Apply to apply the changes. Press
Back to return to the Folder screen.

Follor Hass

Blowsessie ) Ten 9 Ho
PR 3 Yes O HO
Wb s ) Ves @ Ho

| o

Edit Folder

Item Description

Description Provide a description the folder.
Browseable Enable users to browse the folder content.
Public Admit or deny public access to this folder.
Web Access Admin or deny access through web disk.
Apply Press Apply to save your changes.

Cancel Press Cancel to disregard entered data
Back Press Back to return to upper page.

Deleting Folders

To delete a folder, press the Del button from the specified folder row. The system
will confirm folder deletion. Press OK to delete the folder permanently or Cancel
to go back to the folder list.

WARNING

All the data stored in the folder will be deleted once the folder is deleted. The data
will not be recoverable.
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Folder Access Control List (ACL)

On the Folder screen, press the ACL
button, and the Folder Access
Control List (Folder ACL) screen
appears. This screen allows you to
configure access to the specific folder
for users and groups. Use the Read
only, Writable, Deny access, or
Unset radio buttons to configure
access levels for listed users and
groups. Press the Apply button to
confirm your settings.

Faddei

Local Gasegs Lacal Uueis  Baanl only

Frank

)

sesty |

Camial

accolinlasy  Feds s =

Wirlrakle [esy accoss Desan
] o] &

| Eack |

Folder ACL

Item Description
Folder Current folder name
Recursive Check this box if you want your settings to also apply for all

subfolders in current folder.

Local Groups/Local

Names of local groups and local users. Local groups are

Users displayed in red, while local users are displayed in green.
Read Only Provides Read Only access to users or groups.

Writable Provides Write access to users or groups.

Deny Denies access to users or groups.

Unset Resets current user’s/group’s access privilages.

Apply Click Apply to save your changes.

Cancel Click Cancel to exit without saving changes.

Back Click Back to return to the Folder screen.

Service Folders

The N299 automatically creates
folders for its built-in applications.

To manage these service folders,
select Service Folder from the
Storage menu. Press NFS to setup
access privilege. Press Edit to edit
these folders. Press ACL to control
access to these folders via the
Access Control List.

Service Folders

Service Falder

Felder Maine Dascrighlon  WFS ACL  Ea

Fhatas
dag

Wit

UzBCapy
WSBHDD
UEBCam

s[5
\
Husic

UEBCop

UZEHDO
UEBCam

Folder Name Description

Photos Default directory for your photos.

Video Default directory for your video files.

Music Music for the iTunes Server is located here. The iTunes server will
share the music located in this directory.

USBCopy Contents copied from the One-Touch USB Copy function are stored
here.

USBHDD Contents copied from USB hard disks are stored here.

IPCam Stored still frames from the Simple Surveillance Server are stored
here.
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Network Management

Use the Network menu to make
network configuration settings as
well as service support settings.

WAN Configuration

From the Network menu, choose
WAN, and the WAN Configuration
screen appears. This screen displays
the network parameters of the WAN
connection. You may change any of
these items and press Apply to
confirm your settings. You can see a

WAN Configu

Hast Has 120

Dol s ey com
VIAC AdBiass | 00S0ED30FFEE
duinlbo Frasss Support Digahi « bites
Connaction Tyve Spaic |
1P 1721665 108
Motk 35556 55510
Gavenny 172 BB
DS Sarver 172 1GGR0
P Sharig Mess 0 Enala @ Disatla
Byl | et |

description of each item in the

following table:

WAN Configuration

Item

Description

Host name

Host name that identifies the N299 on the network.

Domain name

Specifies the domain name of the N299.

MAC Address

Display the WAN port MAC address.

Jumbo Frame Support

Enable or disable Jumbo Frame Support of the WAN interface on
your N299.

Connection Type

The WAN IP can be set to a Static IP, Dynamic IP, or PPPOE.
Static: Administrator has to enter IP, Netmask, Gateway, DNS
Server fields.

Dynamic: If there is already a DHCP server on your network,
you can let the DHCP server assign an IP address to your N299.
NOTE: If this is set to Dynamic, but a DHCP server is not
detected on the WAN network, the IP address of the N299 wiill
reset to the default setting of 192.168.1.100.

PPPOE: The N299 can also support a direct connection to an
ASDL modem through PPPOE. Once selected, you will need to
enter a User Name and Password.

User Name Enter your user name for PPPoE connection. (PPPOE only)
Password Enter your password for PPPoE connection. (PPPOE only)
IP IP address of the WAN interface.

Netmask Network mask, which is generally: 255.255.255.0

DNS Server Domain Name Service (DNS) server IP address.

IP Sharing Mode

When enabled, traffic on the LAN will be directed to the WAN.
Default is Disabled.

PPPoE Connect

Connect or disconnect from a PPPoE connection. (PPPoE only)

= Only use Jumbo Frame settings when operating in a Gigabit environment where \
all other clients have Jumbo Frame Setting enabled.

= Enabling DHCP automatically turns on UPnP — See the Service Support
Screen.

= If you are only using the WAN port, we suggest that you disable IP Sharing
Mode. This will result in higher throughput.

= A correct DNS setting is vital to networks services, such as SMTP and NTP. /

Most Fast Ethernet (10/100) Switches/Routers do not support Jumbo Frame and
you will not be able to connect to your N299 after Jumbo Frame is turned on. If this
happens, turn off the N299. Then, power on the N299 and immediately press and
hold the Reset button on the rear of the unit for 15 seconds. This will reset your
network settings, password, and turn off Jumbo Frame Support.
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LAN Configuration

The N299 supports a second
Ethernet port for higher service
availability. To configure these ports,
choose LAN from the Network
menu, and the LAN Configuration

diiinb Fiasse SUppoit Dpel!
1P 102168 2 35

screen appears. Press Apply to save e
your Changes s OHCP Sarvie. ) Enshle () Disable

Stat P SZIEEZT

End 1P |§Q'|'f;e'2.|t:0'
05 Sarver |72 16,8534
aoply | Cancel

LAN Configuration

Item Description

MAC Address Displays the MAC address of the LAN interface.

Jumbo Frame Support | Enable or disable Jumbo Frame Support on the LAN interface.

IP Specifies the IP address of the LAN interface.

Netmask Specifies the Network Mask of the LAN interface.

DHCP Server Configuration

Item Description

DHCP Server Enable or disable the DHCP server to automatically assign IP
addresses to PCs connected to the LAN interface. Default is
Disabled.

Start IP Specifies the starting IP address of the DHCP range.

End IP Specifies the ending IP address of the DHCP range.

DNS Server Specifies the DNS server IP address.

Apply Click Apply to save your changes.

Cancel Click Cancel to abandon your changes.

~

= Before enabling Jumbo Frame Support, please make sure your network
equipment supports Jumbo Frame. If your equipment is incompatible, you might
not be able to connect to your N299. In this case, you have to reset the system
back to default by the holding down rear panel reset button for 15 seconds
during boot up process.

= The IP Segment of WAN and LAN should not overlap. j

N
The IP address of the LAN interface should not be in the range of the Start IP
WAR N I NG address and End IP address.
J

DDNS Configuration

The N299 also features Dynamic DNS support. To configure DDNS, choose DDNS
from the Network menu. Press Apply to confirm your settings.

DDNS Support

Item Description

Register Support www.dyndns.org, www.zoneedit.com, www.tzo.com
User Name Input user name that you have register in DDNS domain.
Password Input password that you have register in DDNS domain.
Domain Name Input registered domain name.

Apply Click Apply to save your changes.

Cancel Input Click Cancel to abandon your changes.
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WLAN Configuration

WLAN, and the WLAN

When a compatible wireless USB :
dongle is installed on the N299, the B wom contiguraion
N299 will become an access point, - S e -
and the Network dropdown menu d Motmah 255258 25510 !
will contain a WLAN menu item. mp el == =
From the Network menu, choose i W ... =] E
&'Mm i Sade S8al ) Enable (3 Disabia
Configuration screen appears. This iR =- AR : g
screen displays the wireless network i LD m
parameters of the system. You can i '_"d e e .
to change any of these items and L ﬂ - i
press Apply to confirm your settings. | .. WeRRel [
iy T T—
= Currently supported USB wireless - Staat [P (182 1B 21 .
22&?}2@?&%:7§°3§”Xel G220USB e -
’ v DHE Sorves 1721666244 B

PCI GW-US54mini.
= USB dongles have to be connected
before N299 is powered up.

WLAN Configuration

<

Item Description

MAC Address

Displays the MAC Address of the USB wireless dongle.

IP Specifies the IP address of the network connection.
Netmask Specifies the network mask, which is generally: 255.255.255.0
ESSID The ESSID (Extended Service Set Identification) is the

identifying name of a wireless network.

ESSID Broadcast

Specifies whether the ESSID will be broadcasted by the N299.
This will prevent the Access Point from broadcasting the ESSID.
The N299 will still respond to a wireless device that LAN1ts to
communicate if it sends a matching ESSID.

Channel The channel that the N299 uses to communicate with client
devices.
Auth Mode Authentication mode used by the N299.
Shared: Shared key authentication
Open: Open key authentication
WEP Enable Specifies whether to use encryption for transmission or not.
Key Length Key length specifies the level of encryption used by the N299.
64 bit: 10 characters from O ~ 9 and A ~ F.
128 bit: 26 characters from 0 ~ 9 and A — F.
WEP KEY 1 Input up to 4 WEP keys, and select the one you wish to use.
WEP KEY 2 When connecting, be sure to enter the same key and select the
WEP KEY 3 same index number on each client machine.
WEP KEY 4

A DHCP server can be configured to assign IP addresses to wirelessly connected

devices.

WLAN DHCP Configuration

Item Description

DHCP Server Select to enable or disable DHCP server.

Start IP Specifies the starting IP address of the DHCP range.
End IP Specifies the ending IP address of the DHCP range.
DNS Server Specifies the DNS server IP address.

NOTE The IP Segment of WLAN, WAN and LAN should not overlap. }
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Users should obey the international RF regulatory rules as they set up the wireless
RF channel on the N299. The RF operating channels for different regions have
been specified as following. Thecus has no responsibility for users attempting to
violate the international RF regulation.

11 N. America
14 Japan

13 Europe (ETSI)
2 Spain

4 France

Web Services Configuration

From the Network menu, choose
the Services item, and the Web
Service screen appears. This screen
displays the service support
parameters of the system. You can
change any of these items and press
Apply to confirm your settings. A
description of each item follows:

Web Service

Retwank IdoiTace | [ WAH [5 LAH - WL

Swcure Wen0lsk (5 TF) Suppart
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Upne
WP () Enable & Disable

T ] o |

Item Description
HTTP (WebDisk) Enable or disable WebDisk support. Enter the port number if this
Support option is enabled.

HTTPs (Secure
WebDisk) Support

Enable or disable Secure WebDisk support. Enter the port if this
option is enabled.

UPNP

Enable or disable Universal Plug and Play protocol. UPnP helps to
find the IP address of the N299.

NOTE Disable HTTP support and Enable Secure HTTP support to guarantee secure access. J

Windows Network Configuration (SMB/CIFS)

The N299 can act as a Samba server, enabling users to share files using the
SMB/CIFS protocol. From the Network menu, choose the SMB/CIFS item, and
the SMB/CIFS screen appears. You can change any of these items and press
Apply to confirm your settings. A description of each item follows:

SMB/CIFS

Item Description

Sharing If you are using Microsoft Windows®, enable this service to
access the files on the N299 by mapping a network drive.

WINS Server Specify the WINS server IP address, if your network has a WINS

server installed. The N299 will automatically register its name
and IP address with WINS service.

Work Group / Domain
Name

Enable or disable SMB/CIFS protocol for Windows, Apple, Unix
drive mapping.

= SMB/CIFS service also allows file sharing from Mac OSX and Linux platforms.

= Once a Mac OS accesses a share folder, it will create a file named .DS_Store,
and directories named Temporary items, Network Trash Folder, .Apple Double,
Apple Desktop and AppleDB in the share folder.
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Apple Network Setup

From the Network menu, choose
the Apple Network item, and the
Apple Network Configuration
screen appears. This screen displays
the configuration items for the Apple
Filing Protocol. You can change any
of these items and press Apply to
confirm your settings. A description
of each item follows:

Apple Network Configuration

Item Description

Apple File Service Enable Apple File Service to use the N299 on MAC OS-based
system.

MAC CHARSET If your operating system does not support Unicode (e.g. MAC

0S9/8), select the same language as your OS here in order to
properly view the files and directories on the server.

Zone Specifies Zone for Applet Talk service.

If your AppleTalk network uses extended networks and is
assigned with multiple zones, assign a zone name to the N299.
If you do not Want to assign a network zone, enter an asterisk
(*) to use the default setting.

NFS Setup

From the Network menu, choose T
the NFS item, and the NFS server 0.0 D@06 Pu wa X

e 3 e a
setting screen appears. The N299
can act as a NFS server, enabling
users to download and upload files
with their favorite NFS clients. Make
your changes, and then click Apply
to save them. Click Cancel to return
to the main menu.

o YT

Item Description
NFS Service Enable or disable NFS support
Network Interface Select the network interface for NFS service.
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User and Group Management

The N299 has built-in user database that allows administrators to manage user
access using different group policies. From the Accounts menu, you can create,
modify, and delete users, and assign them to groups that you designate.

Local User Configuration

From the Accounts menu, choose

the Users item, and the Local User
Configuration screen appears. This T
screen allows you to Add, Modify, g T T

and Delete local users. | i fi

o unere

Lagn ugare

You can quickly find a particular user
name by clicking one of the letter
groupings at the top of the window.
For example, to find a user name
beginning with the letter M, click the
MNO user group, and the user
names beginning with M, N, or O will
be listed. To see all names, click ALL.

Local User Configuration

Item Description

User Name Current user name.

Group Group membership of current user name.

Add Press the Add button to add a user to the list of local users.

Modify Press the Modify button to modify a local user.

Delete Press the Delete button to delete a selected user from the
system.

Adding Users

1. Click on the Add button on
Local User Configuration
screen, and Add NEW Local
User screen appears.

Fasewid

2. Enter a name in the User - ~ s oo
Name box.

3. Enter a password in the _
Password box and re-enter | o
the password in the Confirm =
Password box.

4. Select which group the user
will belong to. The Owner Group list is a list of groups this user belongs
to. The Unjoined Group list is a list of groups this user does not belong
to. Use the << or == buttons to have this user join or leave a group.

5. Press the Apply button and the user is created.

NOTE All users are automatically assigned to the ‘users’ group. ]
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Modifying Users
1. Select an existing user from

the Local User
Configuration screen.

2. Click on the Modify button,

Panswid

and Local User Setting e Fciaa

e s

screen appears. = s

3. From here, you can enter a
new password and re-enter to
confirm, or use the << or >=>
buttons to have this user join
or leave a group. Click the
Apply button to save your
changes.

Deleting Users

1. Select an existing user from the Local User Configuration screen.

2. Click on Delete button and the user is deleted from the system.

Local Groups Configuration

From the Accounts menu, choose
the Groups item, and the Local
Group Configuration screen
appears. This screen allows you to -
Add, Modify, and Delete local : ,_ ARG OGF G KL WhD AR ST VRNE G

Gaseg Maine

groups. —_—

RO

You can quickly find a particular
group by clicking one of the letter .
groupings at the top of the window. o daty | o
For example, to find a user name :
beginning with the letter M, click the
DEF letter group, and the groups
beginning with M, N, or O will be
listed. To see all groups, click ALL.

Local Groups Configuration

Item Description

Group Name Current group name.

User Users currently in current group.

Add Press the Add button to add a user to the list of local groups.

Modify Press the Modify button to delete a selected group from the
system.

Delete Press the Delete button to delete a selected group from the
system.
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Adding Groups

1.

4.

On the Local Group
Configuration screen, click
on the Add button.

The Add NEW Local Group & -

Lonlie Passivitd

screen appears. 3 e teees

Enter a Group Name, and
select users to be in this
group from the Users List by
adding them to the Members
List using the << button.

Click the Apply button to save your changes.

Modifying Groups

1.

5.

On the Local Group
Configuration screen, select
a group name from the list.

Press the Modify button and “ L
the Local Group Setting T
screen appears. :

To add a user into a group,
select the user from the
Users List, and press the <<
button to move the user into
the Members List.

To remove a user from a group, select the user from Members List, and
press the >> button.

Click the Apply button to save your changes.

Deleting Groups

1.

2.

On the Local Group Configuration screen, select a group name from the
list.

Press Delete to delete the group from the system.
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System Management

The System menu gives you a wealth of settings that you can use to configure
your N299’s system administration functions. You can set up system notifications,
view system logs, and even upgrade firmware from this menu.

System Notifications

From the System menu, choose the

Notification item, and

Notification Configuration screen
appears. This screen lets you have

the

Hon

the N299 notify you in case of any " .. Boop Wdlication Enalnn @ Oisabla

A : Email Hotidicatien 1 Enahle (3 Disable
system malfunction. Press Apply to e R v B
confirm all settings. See following v
table for a detailed description of Sl ] I
each item. (R

Notification Configuration

Item

Description

Beep Notification

Enable or disable the system beeper that beeps when a problem
occurs.

Email Notification

Enable or disable email notifications of system problems.

SMTP Server

Specifies the hostname/IP address of the SMTP server.

Port

Specifies the port to send outgoing notification emails.

Auth Type

Select the SMTP Server account authentication type.

Sender Address

Set the sender mail address.

Sender Password

Enter the password for the sender’s mail account.

Confirm Password

Confirm a new password.

Receivers’ E-mail
Address

Add one or more recipient’s email addresses to receive email
notifications.

Send Test Mail

Click to send out a test e-mail to make sure the settings are
correct.

NOTE

Consult with your mail server administrator for email server information. J

System Logs

From the System menu, choose the
Logs item and the System Logs

screen appears. This screen shows a Ermssssss & _ e[
history of system usage and i | e S ———
important events such as disk status, B

B Mg i | 2_" angusge sel lo Franch sutees: .
network information, and system = | e e e

detailed description of each item:

AOTORET | ATADE | W183 | USECOPY Stating..

booting. See the following table for a i P 2 T

0NNEE | AT EdILfolder USBGoDT sursesstuly.




System Logs

Item Description

Truncate All Log File Clear all log files.

<< < > >>| Use the forward ( > =>>| ) and backward ( |<< <) buttons
to browse the log pages.

INFO Provides all log information including warning messages and
error messages.

WARN Shows all warning messages and error messages.

ERROR Shows only error messages.

GO Specify the number of lines per page and press Go.

Ascending Shows logs by date in ascending order.

Descending Shows logs by date in descending order.

Download All Log File Export all logs to an external file.

Time and Date Settings

From the System menu, choose the
Time item and the Time screen ;
appears. Set the desired Date, Time,
and Time Zone. You can also elect
to synchronize the system time on
the N299 with an NTP (Network
Time Protocol) Server. You can
change any of these items and press
Apply to confirm your settings. See
the following table for a detailed
description of each item:

Time

Item Description

Date Sets the system date.

Time Sets the system time.

Area Select your area.

City Select your city.

NTP Server Select Yes to allow the N299 to synchronize with the NTP server

shown below.

Select Maually to allow the N299 to synchronize with an NTP
server of your choice.

Select No to not have the N299 to synchronize with an NTP
server.

If an NTP server is selected, please make sure your N299’s network has been setup
WAR N I N G to access the NTP server.

System Configuration Backup and Restore

From the System menu, choose the
Config Mgmt item and the System
Configuration Download/Upload
screen appears. From here, you can
download or upload stored system
configurations. See the following
table for a detailed description of
each item.
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System Configuration Download/Upload

Item Description

Download Save and export the current system configuration.

Browse Click to browse the folder of your PC to locate the configuration
files.

Upload Import a saved configuration file to overwrite current system
configuration.

Backing up your system configuration is a great way to ensure that you can revert
NOTE to a working configuration when you are experimenting with new system settings.

Reset to Factory Default Settings

From the System menu, choose the
Factory Default item and the Reset
to Factory Default screen appears.
Press Apply to reset the N299 to
factory default settings. Press

Cancel to go back to the main menu.

| ResstTo Faservoetiut_______|
W vt

Allhe rannguralions,and user database will be destroyed!
Do o wish 1o continu?

b i

Resetting to factory defaults will not erase the data stored in the hard disks, but
WAR N I N G WILL revert all the settings to the factory default values.

Upgrading System Firmware

From the System menu, choose the
Firmware Upgrade item and the
Firmware Upgrade screen appears.

Follow the steps below to upgrade
your firmware:

1. Use the Browse button to
find the firmware file.

2. Press Apply.

3. The beeper beeps and the Busy LED blinks until the upgrade is complete.

= The beeper only beeps if it is enabled in the System Notification menu.
N OTE = Check Thecus website for the latest firmware release and release notes.
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Change Administrator Password

From the System menu, choose the
Administrator Password item and
the Change Administrator
Password screen appears. Enter a
new password in the New
Password box and confirm your new :
password in the Confirm Password v
box. Press Apply to confirm T
password changes. See the following -
table for a detailed description of
each item.

Change Administrator Password

Item Description

Old Password Type in the current administrator password.
New Password Type in a new administrator password.
Confirm Password Type the new password again to confirm.
Apply Press this to save your changes.

Reboot and Shutdown System

From the System menu, choose Reboot & Shutdown item, and the
Shutdown/Reboot System screen appears. Press Reboot to restart the system
or Shutdown to turn the system off.

ihe syefem or select [Rebool] 1o rehnat the system
Ralioor |

Logout
To logout of the Web Administration Interface, navigate to System > Logout.
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Chapter 4: Additional Feature Setup

Overview

With a bevy of additional features and services, the N299 is so much more than a
mere external hard disk. The sections below show you how you can utilize your
N299 to serve files, music, movies, pictures, and more.

FTP Server

N299 can act as a FTP
server, enabling users to
download and upload files
with their favorite FTP
programs. From the

Network menu, choose ! FIP () Enatle § Disabla
i FTPEMCODE |00
the FTP item, and the oy
FTP screen appears. You kN ' Untasiauinsd
Bnonyssess FTP User .~ Download Only
can change any of these Ho prcess

Hubwark Intestace WaH | Lan | WLan

items and press Apply to o | Gt

confirm your settings. A
description of each item
follows:

FTP
Item Description

FTP Enable FTP Service on the N299.

FTP ENCODE If your FTP client or operating system does not support Unicode

(e.g. Windows® 95/98/ME or MAC 0S9/8), select the same
encoding as your OS here in order to properly view the files and
directories on the server. Available options are BIG5, HZ,
GB2312, GB18030, I1SO, EUC-JP, SHIFT-JIS and UTF-8.

Port Specifies the port number of an incoming connection on a non-
standard port.

Allow Anonymous FTP | Upload/Download: Allow anonymous FTP users to upload or
Access download files to/from public folders.

Download: Allow anonymous FTP users to download files from
public folders.

No access: Block anonymous FTP user access.

Network Interface Select which network interface the FTP server will use. WAN,
LAN or WLAN can be selected.

Anonymous users are not able to delete files on the N299. To delete files, users
NOTE must login and be granted write access on the Access Control List.

To access the share folder on the N299, use the appropriate user login and
password set up on the Users page (Accounts > Users). Access control to each
share folder is set up on the ACL page (Storage > Folder > ACL).

When trying to access N299 anonymously, just enter “anonymous” as the user
name.
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iITunes® Server

With the built-in iTunes
server capability, the
N299 enables digital
music to be shared and
played anywhere on the
network!

From the Network menu,
choose the iTunes item,
and the iTunes
Configuration screen
appears. You may enable
or disable the iTunes
Service from here. Once
enabled, enter correct information for each field and press Apply to save your
changes. See the following table for detailed descriptions of each field:

iTunes Configuration

Item Description

iTunes Enable or disable the iTunes Server.

Server Name Name used to identify the N299 to iTunes clients.

Password Enter password to control access to your iTunes music.

Rescan Interval Rescan interval in seconds. You can click Rescan Now to rescan
immediately.

MP3 Tag Encode Specify tag encoding for MP3 files stored in N299. All ID3 tags
will be send out in UTF-8 format.

Once the iTunes service is enabled, the N299 will make all music located in the
Music folder available for iTunes-equipped computers on the network.

Media Server

With the built-in Media Server
capability, the N299 provides media
streaming service to stand-alone
networked home media adapters that
support the UPnP AV protocol. You
can share digital media such as
music, pictures, and movies with any
compatible device throughout your
entire home.

ADSUCable |

istartace (5 WaH (5 LA (5 WLAN

—T Firgwal —
1P sharing device

WAN
Home PCp camera
=

; .
N1200 RouStor ’
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Media Manager Settings

Item

Description

Media Server

Enable or disable the Media Server service. Click

Shared Media Folders Select the folder(s) that contains media files to be shared. By

default, these include:

e Photos

e Video

e Music

e USBCopy
e USBHDD
e USDCam

Enabled on

With this setting, you can choose if the shared media folders are
available via WAN, LAN, or WAN. Check the appropriate boxes to
access your shared media folders through selected connections.

Adding Media Share Folders

Once the Media Server software is installed, you can start adding folders that
contain the media that you would like to share. To create a media share folder,
follow the steps below:

1. Click on Network > Media Server in the menu bar.

2. Select the folder that contains your media files, and click the checkbox.

3. The contents in the folder will be scanned for the Media Server. The time
required for scanning depends on the size of the folder.

Connecting DMASs to the Media Server
Next, it’s time to connect your Digital Media Adapter (DMA) to the media server:

1. Connect your DMA to your Media Server

a.

b.

Configure your DMA to use a Dynamic IP address. The IP address
will be assigned by the router.

Some DMAs are wireless enabled. You can connect the DMA to a
wireless router. For instructions on how to connect your DMA to a
wireless router, please refer to your DMA’s user manual.

2. Connect your DMA'’s video output to video input of your TV set.

3. Turn on the TV and change the video signal input to DMA.

4. Setup the DMA (These steps will be different if you use a different DMA)

a.

From the Server List screen, select “N299:Mediabolic Server” as
the server.

Go to My Media

Click on the Up/Down Arrow buttons to select Music Jukebox,
Photo Albums, or Video Clips

Start enjoying the contents stored in your N299.
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Download Manager

With the built-in
Download Manager,
you can have the
N299 download HTTP, I oo
FTP, and BT files 2

without having full PC
powered on. What's
more, you can even

Taek Type {HTTE »
HITE

Downigad Soh;

schedule your T -l e
downloads for off-peak .: — =
hours, ensuring oA e = Hourl ] Winute
efficient use of o :

bandwidth.

Enahle Refmsh

Download Tasks

Item Description
> Click to start the specified task.
. Click to pause the specified task.
Click to delete the specified task. A prompt will appear asking you
)( if you would like to delete the task itself, or the task and all
related downloaded files.
Task Name of the task. Click to see more information about this task.
Type Type of transfer. Can read HTTP, FTP, or BT.

Transfer rate of the task in kilobytes per second (KB/s).

Rate DL: Download rate
UL: Upload rate
Status of the task.

Status Complete: Percentage complete (%)
Completed / Total download size

Use this dropdown to select the type of transfer. HTTP, FTP, and

Task Type BT are available.
Add Task Click to add the kind of task specified beside “Task Type”.
Enable Refresh Click to refresh the task list.

Adding an HTTP Task

To add a new HTTP task to the Download Manager, follow these steps:

1. Using the Task Type dropdown, select HTTP and click Add.

2. In the HTTP Task window, start by inputting the target URL in the
Website URL box. This is the link to the download you want to queue.
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3. Next, select the destination folder from the Destination Folder dropdown.
This is where the download will reside.

4. Select the maximum download bandwidth from the Max. Download
Bandwidth dropdown.

5. Press Apply to add the task.
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6. Once added, your download will appear in the list of download tasks. To
start the download, simply click the Start icon (®) and the download will
begin.

8. The download status will continually update in the Download Tasks
window. To pause the download, click the Pause icon (.).

Adding an FTP Task
To add a new FTP task to the Download Manager, follow these steps:

1. Using the Task Type dropdown, select FTP and click Add.
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2. In the FTP Task window, start by inputting the target URL in the FTP File
box. This is the link to the download you want to queue.

3. Next, select the destination folder from the Destination Folder dropdown.
This is where the download will reside.

Unarmarms |
Fasimed |
M o Mimdwbdth 108 = k30
B |

4. The next step depends if you are using an anonymous login for your FTP
download. If you are logging in anonymously, select Enable and move on
to step 5.
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If you are required to login with a user name and password, set
Anonymous FTP to Disable and input your user name and password into
the appropriate fields.

G; '

5. Select the maximum download bandwidth from the Max. Download
Bandwidth dropdown.

e
Bestingtion Fulder st w

Ay 118

6. Press Apply to add the task.

7. Once added, your download will appear in the list of download tasks. To
start the download, simply click the Start icon (®) and the download will
begin.




8. The following prompt will be shown when the download begins:

9. The download status will continually update in the Download Tasks
window. To pause the download, click the Pause icon (.).

Adding a BT Task
To add a new BT task to the Download Manager, follow these steps:

1. Using the Task Type dropdown, select BT and click Add.

2. In the BT Task window, start by clicking Browse... and selecting the
torrent file you wish to start.
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Tatram T € Gocamerts and ey

Next, select the destination folder from the Destination Folder dropdown.
This is where the download will reside.

Next, you can designate the Sharing time after completion by selecting
the number of hours from the dropdown.

Tatram T € \Goocamerts and Sqties (IR

Next, you can select the maximum and minimum number of peers from
selecting the counts from the appropriate dropdowns.

Next, you can set the maximum download and upload bandwidths from
the dropdowns below.
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8. Once added, your download will appear in the list of download tasks. To
start the download, simply click the Start icon (®) and the download will
begin.

10. The download status will continually update in the Download Tasks window.
To pause the download, click the Pause icon (.).
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Deleting Tasks
To delete a task, simply follow the steps below:

1.

Click the delete icon (X) beside the task that you wish to delete. The
Delete Task dialogue box will appear.

Select Delete Task only if you wish to remove only the torrent file and all
transient files, leaving the unfinished download files intact.

Select Delete Task and Files if you wish to remove the torrent file and
all transient files, and the unfinished download files.

Click OK to delete the task. Click Cancel to return to the Download
Manager.

Scheduling Downloads

You can schedule your downloads to begin at different times of the day. This is
useful if you wish to complete your downloads during off-peak hours, reserving
your bandwidth for other applications. A table describing the Download

Schedule window appears below:
Download Schedule

Item Description
Schedule Stat Enable or disable the Download Scheduler.
Choose to have the Download Scheduler activate on a daily or
Frequency .
weekly basis.
Start Time Specify the start day/hour/minute for the download task.
End Time Specify the end day/hour/minute for the download task.

To schedule downloads, follow these steps:

1.

Under Download Schedule, set Scheduler to Enable.




2. To schedule a daily download period, select Daily and select a start time
and end time.

To schedule a weekly download period, select Weekly and select a start
day/time and end time/day.

3. Click Apply to save your changes.

If the Download Scheduler is enabled, ALL download tasks will adhere to the
N OTE designated schedule.

Printer Server

You can configure the N299 to act as a printer server. That way, all PCs
connected to the network can utilize the same printer. From the Status menu,
choose the Printer item, and the Printer information screen appears. To setup
in either Windows XP or Vista, please refer the following for steps.

Windows XP SP2 — o

1. Connect the USB
printer to one of the

USB ports 1 .
(preferably the rear — ] . cu s
USB ports; front USB . pumi Dt |_ ISR ol

ports can be used for
external HDD
enclosures).

2. Go to Start >
Printers and Faxes.

3. Click on File > Add Printer.
4. The Add Printer Wizard appears on your screen. Click Next.

5. Select the “A network printer, or a printer attached to another
computer” option.

53



6. Select “Connect to a printer on the Internet or on a home or office
network”, and enter “http://N299 1P_ADDRESS:631/printers/usb-
printer” into the URL field.

7. Your Windows system will ask you to install drivers for your printer. Select
correct driver for your printer.

8. Your Windows system will ask you if you want to set this printer as
“Default Printer”. Select Yes and all your print jobs will be submitted to
this printer by default. Click Next.

9. Click Finish.

= Not all USB printers are supported. Please check Thecus website for a list of
supported printers.

= Note that if a multi-function (all-in-one) printer is attached to the N299, usually
only the printing and fax functions will work. Other features, such as scanning,
probably will not function.

Windows Vista
To set up the Printer Server in Windows Vista, follow the steps below:

1. Open Printer Folder from the Control Panel.

ToTaa

I B crmmitems “ll| 2

2. Click the right mouse button in anywhere on the Printers folder and then
select Add Printer.

ol
(@8 B Epyr——rp—pr— v [ 4y || searcs £
3 Docoments  Sesun Commants  locston  Modd
Microsott KP4 Document
B
View 0
Sonly *
Grovp By
Retiesh
Unda Copy. ool

¥ Run i admisismanee

Add Printer..
Serves Prepertes...

3. Select Add a network, wireless or Bluetooth printer.

g =

(;) = Add Printer
Choose a local or network printer

% Add a |ocal printer
Use this option only if you don't have a USE printer. (Windows automatically
installs USB printers when you plug them in.)

= Add a network, wireless or Bluetooth printer
Make sure that your computer is connected to the network, or that your Bluetooth
or wireless printer is tumed on.

e




4. Select The printer that 1 want isn’t listed.

@ s Add Printer

Searching for available printers...

% The printer that I want isn't listed ‘

Next Cancel

You can press The printer that I want isn’t listed to go into next page
without waiting for Searching for available printers to finish.

5. Click Select a shared printer by name.

=

@ 0 Add Printer

Find a printer by name or TCP/IP address

*) Browse for a printer
@ Select a shared printer by name

hitp://<Thecus_NAS_IP >:631/printers/usb-printer Browse..

Example: \\computername'printername or
Rt e

Add a printer using 3 TCP/IP address or hostriame

Cancel

Type http://<Thecus_NAS>:631/printers/usb-printer in the box,
where <Thecus_NAS_IP> is the IP address of the N299. Click Next.

6. Select or install a printer and then press OK.

Add Printer Wizard -5 eEal

J Select the manufacturer and model of your printer. ff your printer came with
=%  aninstallation disk, click Have Disk. F your printer is not listed, consult your
B printer documentation for a compatible printer.

Manufacturer o Printers o
HP — | | BFHP DeskJet 615C i
1BM B HP Desklet B40C/B420/6480

infotec E3F HP Deskjet 6500 Series

Karica = let BENC I
KOINICA MINOITA i || i l

_5,-}' This driver is digitally signed. | TR
Tell me why driver signing is important ==

55



If your printer model is not listed, please contact your printer
manufacturer for help.

7. Windows will attempt to connect to the printer.

Connecting to
http://172.16.66.64:631/printers/usb-printer

| — |

8. You can choose to set this printer as the default printer by checking the
Set as the default printer box. Click Next to continue.
ﬁ
(o) % AddPrnter
Type a printer name

Erinter name: ushprinter on hitp: /{172 16.56.54:531
et 2 the defoult ponten
This printer has been h e dr

9. Done! Click Finish.

() = Add Pinter

You've successfully added ush-printer on httpy//172.16.66.64:631

To see if the printes is working comecty, o b see boubleshooting information for the printer, print
& test page.

Prind 3 test page:

IP Cam Surveillance

With the Simple Surveillance

Server, you can connect an IP
cam to the N299 to capture ;
images. The Simple ' _ _ el
Surveillance Server also . DR e e
supports scheduling, which T —
means that you can configure

the N299 to perform home

Sehedule S1al & Enable 0 Disable

surveillance at any time. ' O T —

Sraen Tiine Hour:

From the Status menu,
choose the IP Cam
Surveillance item, and the

56



IP Cam Surveillance Information screen appears. The IP Cam screen provides
information and allows you to configure the Simple Surveillance Server.

Item Description

Location Specify the location where the IP Cam located.
URL Input the URL address to capture the image.
Interval Designates the interval for each captured frame.
Folder Input where the images will reside.

Action Click ADD to add the task, Delete to remove task.
Apply Click Apply to save changes.

Cancel Click Cancel to abandon changes.

To designate a schedule for the Simple Surveillance Server, click Schedule, and
the Schedule Configuration window will appear:

Schedule Configuration

Item Description

Schedule Start Checked on enable to activate image capture.

Frequency Frequency of the schedule. Select from Daily and Weekly
Start Time Scheduled time for image capture to begin.

End Time Scheduled time for image capture to finish.

Apply Click Apply to save changes.

Cancel Click Cancel to abandon changes.

IP Cam Configuration

Setting up an IP Cam for use with the N299 is easy. In this example, we’ll setup a
Vivotek PT7237 IP cam for use with the N299. Configuring a different IP cam will
be slightly different depending on the model you are using, but this guide will

outline the basics.

Follow the instructions included with your IP cam for installation. Once your IP
cam is properly installed, follow the steps below to configure your N299.

Step 1: Connect the IP Cam to the N299

The first step is to connect your IP cam to the N299. To do this, login to the
N299’s Web Admin Interface and select IP Cam Surveillance from the menu.
The IP Cam Surveillance window will appear. Here, we will connect your
installed IP Cam to the N299.

In this window, you will be asked to fill in some basic information about your IP
camera. Let’s go through each field in order:

Location: Here, you can designate
a location that the IP cam is
located. For example, if the IP cam
is currently monitoring your office,
you can enter “office” in the blank.
Choose a name that is meaningful
will make it easier to refer back in
the future.



URL: This is where the URL for your IP cam is entered. Every IP cam has a URL
that is provided which links to a landing page for all captured images. In this
example, the Vivotek PT7237 uses the following URL:

http://172.16.66.95/cgi-bin/video. jpg
Please refer to your IP cam manual for the appropriate URL to enter into this field.

Interval: Here, you can designate the time between each captured image. Select
the desired interval from the dropdown menu.

Folder: Enter the name of the folder you wish the N299 to store captured images
to.

Once this information is entered, simply click Add.

After clicking OK to the resulting prompt, your IP cam will appear in the IP Cam
Surveillence window.

o4

.....

Step 2: Designate a Capture Schedule

Once connected, the next step is to create a capture schedule for your IP cam. To
do this, enter the correct information into the Schedule window.

Let’s take a closer look at each
field:

Schedule Stat: To enable the
scheduling function, click
Enable.

If the scheduling function is set to Disable, images from any connected IP cameras
will not be saved onto the N299.




Frequency: Here, you can set the frequence of the schedule to either Daily or
Weekly. When set to Daily, images will be captured every day at the designated
time. When set to Weekly, you can have the IP camera capture images at certain
days of the week (i.e Monday to Friday).

Start Time: Choose the start day and time for image capture. If you've selected
a Daily frequency, you will be unable to select the start day as the IP camera will
be set to capture images every day.

End Time: Chosse the end day and time for image capture. If you've selected a
Daily frequency, you will be unable to select the end day as the IP camera will be
set to capture images every day.

Once you are finished, click Apply to enable your new schedule.
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Step 3: Browse Captured Images

Once the capture schedule has been set, you can browse the captured images on
the N299. The easiest way to do this is to simply open the folder you previously
designated as the capture directory and view your captured pictures using your
favorite photo viewing software. In the example above, all captured images will
appear in the 1PCam folder.

W b O I

Alternatively, you may also use the built-in web-based Photo Gallery to view your
pictures. For information on how to set up the Photo Gallery, check here.
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Chapter 5: Using the N299

Overview

Once the N299 is setup and operating, users on the network may manage all
varieties of digital music, photos, or files by simply using their web browsers. To
manage your personal files or access public files on the N299, just enter its IP
address into your browser, and you will be taken to the N299 Login page.

Login Page
On the login page, simply enter your User ID and Password and click Login to
log into the system.

mis)  N299

oy 10 | Fassward: Logn

Theerars Todwalogyy Corporatan S 3004 A righls nesdnaea

Once logged in, you will be seen the icons for WebDisk where you can see the
directories and files stored on the N299.

Using WebDisk

1. From the WebDisk folder list, users will see all public folders and all folders
which they have sufficient access rights.

WebDisk Folder List

Item Description

Name Name of folder

Comments Comments about folder
Change Password Click to change your password
Logout Click to logout of the WebDisk

2. When they click on the name of a folder, they will be brought to the Folder
Screen, where they will see the files within that folder.

WebDisk Folder Screen

Item Description
Name Name of folder
Type File type

Size Size of file
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Modified Date Date file was last modified

Change Password Click to change your password

Logout Click to logout of WebDisk

Up Click to go up one directory level

New Folder Click to create a new folder

New File (upload) Click to upload a new file to this folder
Delete Selected Items Click to delete all checked items

3. When user clicks on a file name, the file will be downloaded.

The Delete Selected Items, New Folder, and New File (upload) options are only
NOTE visible if the user has write access to the specific folder.

For more information on how to setup user rights to the folders, please check
Chapter 3: System Management > Storage Management > Folder
Management > Folder Access Control List (ACL)

To access folders with access control, you must first login with a local user
account.

Using iTunes® Server

The N299 has a built-in iTunes® Server that allows you to stream music stored
on the N299 to any iTunes-ready device on your network.

You can use the WebDisk function to manage your digital music, or you can
manage through SMB/CIFS (see SMB/CIFS Setup section).

Adding Music Files

You could add music files into iTunes Server through Web User Interface;
however, if you have lots of folders and files to upload, there is a simpler way.

1. Open a Windows Explorer and type the N299 IP address in the address bar
(i.e. \\192.168.1.100).

2. Double click the Music folder to enter it. Then drag and drop music folders
and files here.

3. The N299 iTunes server will take some time to cache the ID3 tag of every
file. Once the process is done, you will see all the music files from iTunes
clients.

Playing Music Files
Once your music files are added to the N299, playing them on any iTunes-
equipped computer connected to the network is easy:

1. Open iTunes.

2. You should see Thecus_N299 under the SHARED heading in the left
hand menu.

3. Click Thecus_N299 and all shared music will be displayed, ready to be
enjoyed right from iTunes.
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Using Photo Gallery

Using the Photo Gallery, users can
view and share photos, and even
create their own albums right on the
N299. To manage your photo gallery
or see other photo albums, click on
the Photos icon from the left panel.

You will see your own Photo Gallery
and all public Photo Albums on the
network.

To manage any picture files, you
must first select the item by clicking
its check box.

Managing Albums and Photos

Photo
Icon Function Description
"';;r Make Cover Make selected photo your cover picture.
(LN
'-'I'_' Add Add a new album or photos.
& ':" Edit Edit the name and description of the selected album or
e photo. Each name is limited to 20 characters and each
description is limited to 255 characters.
B Delete Delete the selected albums or photos.

< Only logged in users will see these icons.
= To prevent system errors, the N299 sets the following limitations on photo files:
= Each file upload is limited to a size of 4MB. Files exceeding 4MB will NOT
be uploaded and no error message will appear.
= Only these photo file types will be uploaded: *.jpg, *.gif, *.bmp, *.png,
*.pcx, *.psd, *.bmp.
= If duplicate file names exist during upload process, system will add a
number in front of the original file name (abc ( labc).

Creating Albums
To create a photo album, follow the steps below:

1. Click the Add button to create a new album.

2. Enter a name for the album, and enter a description if you wish. Then,
click on the Create Album button.

Password Protecting Albums
If you would like to put a password on a particular album, follow these steps:

1. Select the album to be protected, click on the Edit button, and the Album
Edit screen will appear.
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2. The owner of the album can enter an album password to protect the
album, so that only people with the correct password can view the album.

Uploading Pictures to Albums
Uploading pictures to albums using the Web User Interface is easy:

1. When the album is created, click the album icon to enter the album.
Initially the album is empty.

2. Click the Add button to upload pictures into the album. The Upload

Photos screen will appear. Users can select and upload up to 8 pictures at
a time.

3. Once the picture is uploaded, you can view it in the album.

4. The owner of the album can delete or modify the pictures with the Delete
or Modify buttons on the top right hand corner.
Windows XP Publishing Wizard

There are many ways for a local user to upload pictures into their photo album.

Users of Windows XP can upload their pictures using the Windows XP Publishing
Wizard.

1. Click on the XP Publishing Wizard icon.

2. The XP Web Publishing Wizard Client screen appears. Click on the link
to install the Publishing Wizard.

XP Web Publishing Wizard Client

This fusection allows t0 Use Widdieres NP web pblishing wizard wEh N2DO.

What is required
w Windowe XF in arder 1o fve the wizaid

How to install on client side

« Flighkdlick N elect save torgst o, Sawe the fils onyour fierd
drive. e file, chack that tha propesad fle nama is
¥PPublishreg. Vhan dowrinacad, doubla cick an the flzin anderto
rsglater your server vath e wab publishing wizard

(O el &N )

How ta publish

= [0 Windows Explorer, select soma filas and chckon Publish o0 on the
Wit i M pang:

» Whenitis camplated, check your palery b ses if pictures hiavs baen
prapary aoded.
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3. Windows XP will ask whether you want to run or save this file. Click Run.

File Download - Security Warning

Do you want to run or save this file?

@ Mame: xPPublish.reg
Type: Reqistration Entries, 373 bytes

From: 172.16.66.147

(&0 ][ Save ]| Cancel |

I | “while files from the Internet can be useful, this file type can
’ potentially harm pour computer. [f pou do not tust the source, do not
ST un o save this software. What's the rigk?

4. Once the Wizard is installed, use the Windows file manager to browse the
folder that contains the picture you want to publish. On the left pane,
there will be an icon labeled “Publish this folder to the Web”.

Web Publishing Wizard X

Welcome to the Web Publishing Wizard

This wizard will help you publish wour files aver the Internet ar a local network
50 that ather people can view them in their Web browsers,

To continue, click Next,

Cancel
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6. Select the pictures you want to publish to the Photo Web Server by placing
a check mark on the top left hand corner of the picture. Click Next.

Chasreges Yori Fe 5 elacinn
“W'ons . prlberh T et that e checl man. 1 jrou 60 mol mad 1o publish il clear B
chach bow

; 2 G ] =]
— & E il
5 =
ni -
Bl

=] = = =
IE .!_., E ‘ - ~

55 bimn pboctod ol 50 et A4 ] _fewid
[ e sk [t » Carcal

-] L
=)

7. Your PC will start to connect to the Photo Web Server.

8. Select N299 Photo Gallery Wizard to publish your pictures to the N299.

‘Where do you want to publish these files?
>

Select a service provider to host your Web site. If you do not have a membership account, one wil be
created for you.
Service providers:

MSN Groups

Share yaur files with others, or store them for your personal use.

™
[ < Back H Hewt » 1 [ Cancel ]

9. Login into the N299 with your local user name and password.

FEE M=

W299 Photo Gallery Wizard
Fowersd by Theous

Please input ID and Password

(%) (2w [ =8

10. Create your album by entering an album name and clicking on the Create
Album button.

66



HaRhEE X
NH299 Photo Gallery Wizard “-
Powered by Theeus @
<

-~
Service On Gallery
Please Select album To Upload : | Travelling
Album name : | [ Create Album ]
_;: wﬂ
b2
b »

i

11. Select the album you want to upload your pictures to.

12. Confirm the target album.

HAREha=

N299 Photo Gallery Wizard -
Fowered by Theens ;Q\‘

The selected Album is Travelling.

Are you sure publish photos into the Album?

Travelling
_‘;—\ mﬂ
™
| b

F—Fm - B

13. Windows will show you that the picture upload is in progress.

Sk - EEdEEhEE
&

HE
product folder

BIREE: 100% TR
(

BRIEFES 30 EEREPE 9 #@

(I

i

EEfILER - 5 @uE) -

14. When the upload is finished, the Wizard will ask you whether if you want
to go to the website. Click Finish to go to your Photo Web Server.

67



Web Publishing Wizard 3
Completing the Web Publishing Wizard
You have successfully published pour files ta this site;

1200 Pholo Gallert
[pen this site when | dlick Firish

To close this wizard, click Finish.

[ <Back ][ Fish | [ Cancel |

15. Click on the user’s icon to go to that user’s album.

iE

16.'You will see the user’s album list. Click on MyAlbum.
Tm@ = N299

C| s rtin 02000




EXIF Information

While viewing pictures, you can also have the N299 display the EXIF information
for each photo.

)

Fissaine: B a0 g
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Slide Shows
Slide shows are a great way to enjoy pictures stored on your N299.

You can click on the Start Slide Show icon on the top right hand corner to start
the slide show.

<)

Py | 80T oo b,
Fole Size ) SIERS fnaen
Tmage Height |

Tmage Wiah |

&)

Py
Facal g |
Esganiii Tine
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B
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i

To stop the slide show, click on the Stop Slide Show icon on the top right hand
corner.
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File Backup

There are a number of ways to back up your data to your N299.

Nsync

You can backup a share folder to
another N299 (Nsync Target) or any
FTP server for safe keeping as long
as you have appropriate access right
on that target. When using Nsync
between two N299s, you have the
option to transmit files securely
between two N299s.

If the files on your N299 are lost for
any reason, you can restore those e
files from the target N299. To backup files regularly, you can set up a scheduled
task to run only once, daily, weekly, or monthly. You can also limit the bandwidth
of your Nsync tasks, so other users on the network can share the bandwidth
equally.

Under the Storage menu, click Nsync and the Nsync window appears. Below is
a description of each field:

Item Description

Task name The name of your Nsync task.

Server The IP address of your target server

Share folder The share folder you would want to backup.

Last Time The time when the last Nsync task was executed.

Last Status The status of your last Nsync task.

Action Administrator can run or stop an Nsync task by pressing the
action button.

Bandwidth Setting Bandwidth control on Nsync tasks.

Add Click to add a Nsync task

Modify Click to modify an Nsync task.

Restore Restore share folder from an Nsync target.

Delete Click to delete an Nsync task. Backup files on Nsync target is
also deleted.
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Adding an Nsync Task

From the Nsync Information
screen, click Add to display the
Add Nsync Task screen.

Add Nsync Task

Item Description
Task Name The name of your Nsync task.
Manufacturer Select whether the target is a Thecus Product (e.g. N299) or FTP

server.

Target Server IP
Address

The IP address of your target server.

Source Folder

The share folder you want to backup.

Nsync Task Name

The name of your Nsync task.

Authorized Username
on Target Server

The account name on the target server.

Password on Target
Server

The password for the username on the target server.

Test Connection

Click to check the connection to the Target Server.

Schedule Schedule backup of your share folders.

Time The time when the Nsync task will run.

Type Select whether to run the Nsync task daily, weekly, or monthly.
Daily: input the time of day to execute Nsync task.
Weekly: input which day of the week to execute the task.
Monthly: decide which day of the month to execute the task.

Apply Click to submit the task.

NOan=

Before starting an Nsync Task, make sure the target server’s Nsync Server (or FTP
Server) is enabled.

Modifiying an Nsync Task

1. On the Nsync window, select the
Nsync task you would like to
modify by checking its checkbox.
Click Modify and the Modify
Nsync Task window appears.

2. Change the settings for your Nsync

task.

3. Click Apply to save your settings.

Deleting an Nsync Task
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1. On the Nsync window, select the Nsync task you would like to delete by
checking its checkbox.

2. Click Delete to remove the selected Nsync task.

Setting Up an Nsync Target on an Nsync Device

On the Nsync target server, the administrator of that server has to set up a user
account with a folder named “nsync” and grant write access.

1. On the Nsync server, add a user for Nsync source (ex. nsyncsourcel). For
instructions on how to add a user on the N299, see Chapter 4: System
Management > User and Groups Management > Local User
Configuration > Adding Users.

2. On the Nsync server, grant that user (ex. nsyncsourcel) write access to
the nsync folder. For instructions on how to set up a folder’'s ACL, see
Chapter 4: System Management > Folder Management > Folder
Access Control List (ACL).

3. Once this is done, the target server will start accepting Nsync tasks from
server using that ID and password.

Setting Up an Nsync Target on Another Device

If you selected “Other Device” when setting up your Nsync task, the N299 will use
the FTP protocol to back up the share folder. On the external storage device,
make sure there is a folder named “nsync”, and the Auth ID has writable
permission in that folder.

Designating N299 as an Nsync
Target

The N299 can act as an Nsync server,
enabling another Nsync-equipped
Thecus NAS at a remote location
backup their files to this N299. From
the Network menu, choose the
Nsync Target item, and the Nsync
Target Server Setting screen
appears.

Nsync Target Server Setting

Item Description

Nsync Target Server Enable or Disable Nsync Target support.
Apply Click Apply to save your changes.

Cancel Click Cancel to cancel your changes.

To enable Nsync task to go thru firewall, you have to open port TCP/1194 on your
NOTE firewall in both directions.

72



Thecus Backup Utility

The Thecus Backup Utility is on your Installation CD. When you click on the CD,
the Backup Utility will be installed under Program Groups > Thecus > Thecus
Backup Utility. If it is not installed, you can copy the file (Thecus Backup
Utility.exe) to a convenient location on your hard disk and double click to

execute it.

NOTE

If you can not find Thecus Backup Utility on your CD, please download it from the

Thecus website (http://www.thecus.com).

]

When you execute this utility for the first time, it will ask you whether to create a

DB file. Click Yes.

1. Click Add to create a Backup task. The Add New
Task dialog box appears.

£7 244 new task

Source

O Increamental

Destination:

Excluded exensions(Optional):

mp

" trash

Comments(Optional):

Add

Cancel

Add New Task

Item Description

Task Specifies a name for the current task.

Source Click to specify the source folder/file location.

Incremental Click to specify whether the backup will be incremental.
If unchecked, the backup will be a full backup.

Destination Click to specify the destination folder/file location.

Excluded extensions

Files with these file name extensions will be skipped and not

back up to the destination.

Comments

If you wish, enter comments here for your records.

2. To schedule the task to run at regular intervals, click on the Schedule
icon for that task. You can schedule the task to run Monthly or Weekly.
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Thecus Backup Utility ‘

Tasks Log

Task Source Destination Schedule

[ Taskt [ \ | o (T %, Mone

Cmaa] |

3. To check the log for that task, click on the Log icon for that task.

Thecus Backup Utility also supports MAC OS X. Just copy the Thecus Backup
NOTE Utility.dmg to your MAC OS X machine and double click to execute it.

Windows XP Data Backup

If you use Windows XP Professional, you can also use the Windows Backup Utility
(Ntbackup.exe) to backup your files.

If you use Windows XP Home Edition, follow these steps to install the utility:

1. Insert the Windows XP CD into a drive and double-click the CD icon in My
Computer.

2. When the Welcome to Microsoft Windows XP screen appears, click
Perform Additional Tasks.

3. Click Browse this CD.
4. In Windows Explorer, navigate to ValueAdd > Msft > Ntbackup.
5. Double-click Ntbackup.msi to install the backup utility.

Once installed, you can use the Windows Backup Utility by following the steps
below:

1. Click Start, and point to All Programs > Accessories > System Tools
> Backup to start the wizard.

Backup or Restore Wizard El

Welcome to the Backup or
% Restore Wizard
o

This wizard helps you back up of restare the files and
setings on your computer

If you prefer, you can switch to Advanced Mods to changs the
seftings sed for backup or restore. This option is recommended
for advanced users anly

Alvaays start in wizard mode

To continue, click Mest

2. Click Next to skip past the opening page. Choose Backup files and
settings from the second page, and then click Next.
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3. Select which option you Want to back up.

4. Click Next and in the Backup Type, Destination, and Name page, specify a
back up location using the Browse button.

5. Find and select the drive that specifies your N299 as your backup
destination and click Next.

6. Click Next to display the wizard’s final page and click Finish to start
backing up.

Apple OS X Backup Utilities

Mac OS X does not include any backup software. However, there are a number of
backup solutions available for the Mac OS X, including: iBackup, Psyncx, iMSafe,
Rsyncx, Folder Synchronizer X, Tri-BACKUP, Impression, Intego Personal Backup,
SilverKeeper, and Apple's dotMac Backup utility to name just a few. To find even
more freeware and shareware backup utilities to choose from, go to
VersionTracker or MacUpdate and search on "backup".

One-Button USB Copy

The N299 can quickly backup data from USB devices with its One-Button USB

Copy function. To use this function, plug a USB storage device to the N299’s front
USB port. Then, simply press the One-Touch USB Copy button on the front panel,
and all of the contents of the USB storage device will be copied over to the N299.

All of the files copied will be contained in the USBCopy service folder, under a
subfolder names with a timestamp (YearMonthDayHHMM). For more on the
N299’s service folders, check out Chapter 3: System Management > Storage
Management > Service Folders.
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http://homepage.mac.com/sweetcocoa/imsafe/
http://www.macosxlabs.org/rsyncx/rsyncx.html
http://www.softobe.com/products/flsy/pp.html
http://www.tri-edre.com/english/tribackup.html
http://babelcompany.com/impression/
http://www.intego.com/personalbackup/home.html
http://www.lacie.com/silverkeeper/
http://www.versiontracker.com/
http://www.macupdate.com/

Chapter 6: Tips and Tricks
Mapping a Client PC to the N299

You can map share folders on the N299 so that you can access them as if they
were drives on your computer. You can connect to the shared network folders on
the N299 as follows:

Windows

1. Go to the My Computer folder in Windows.

ECTE eEd!
[on = o= reem o= 3

BCCB TG

1| R Help

Map Metwork Drive...
Disconnect Mebwork Drive, .,
Synchronize. ..

Folder Options. ..

3. The Map Network Drive window appears.

=]
¥indova con help +ou conmick ko e shared rsbveor Folder

ord e o ohive btter b e commcbon o kbt voucen
a006ss e fd e psng My ComaLkar,

SomcFy Hom ol Ietter Fior e conrection and he fokder
et you want o ot bo:

PW" vk Orive

Pk 2168 Lioned o] [ e
Exampls: | 'pham
[FlEmrect 2 kmm
okt udng 3 o Farant Liser radia.

L £

etk prenc
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4. Assign a drive letter for the share folder.

5. Click the Browse button to find the folder over your network. Alternatively,
you may enter the folder name you wish to connect to or enter its IP
address. (i.e. \\192.168.1.100\share)

6. Click Finish. When the Connect As... window appears, enter a user name
and password.
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‘Connect As... ﬁ
By default, vou will connect ta the network folder as

LAPTOPYCK Wang. To connect as another user, enter their
user name and password below,

User name: | o) | Browse..,

Password: | ]

7. Click OK. The share folder appears as the drive you assigned. You can now
access this folder as though it were a drive on your computer.

iy Computer = |

Be E% Yew Fgemes [k fen &

Quak - O - [} P seah yrodes O}

sdves | § o Cornte = B
m

o Tasks. & = % el
Systemn T g 1o Dk () R S s

==

25 Add or racocem gl 2000 on P o EX Packet gl Softrare on P ot EZ Pucket
(vwass 0.y (v (91680, 09 (2:)
—

= |_’_.J Shered Duraumerts |_,_J X W Docments
Othes Places F

Apple OS X

On an Apple computer, you can connect to shared computers and servers using a
network address.

1. Choose Go > Connect to Server...

m Window Help

= Computer {r3€C
# Home {+3%H
% Network {r 38K
@ iDisk >
& Applications ratA

Utilities o 1]
Recent Folders >
Go to Folder... %G

Connect to Server... 3K

2. Enter the network address for the server in the Server Address text box.

s Xa ki Connect To Server
Server Address.
afp:/(192.168.1.100/Falder] +| [@.

Favorite Servers

_Browse ) { Connect )

When connecting using SMB/CIFS protocol, type:
smb://192.168.1.100/Folderl

When connecting using AFP protocol, type:
afp://192.168.1.100/Folderl

Click Connect.
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3. When MAC OS X is trying to connect N299, it will ask for a User Name and
Password which has access to the folder.

0680 Connect to Server

- Connect to the file server “N2100."
)

Connect as: [ Guest
(O] Registered User

Name:

Password:

"I Remember password in keychain

E+ ( Cancel ) (Connect)

4. When MAC OS X has connected to the N299 successfully, an icon
representing the folder will appear on the MAC OS X desktop. You can
access the folder by double clicking on the icon.

Folderl

USB Storage Expansion

The N299 supports external USB hard disks through its two USB ports. Once a
USB hard disk has been successfully mounted, users can access the files on the
USB hard disk under the USBHDD folder. The N299 supports up to 6 USB
external storage devices. All file names on the USB disk volume are case sensitive.

Before attaching a USB disk drive to N299, you have to partition and format it on
a desktop computer or a notebook first. The attached device will be located at
\\192.168.1.100\usbhdd\usb1\1\ where 192_.168.1.100 means the IP address
of N299, usb1l stands for the first USB device, and 1 stands for the first partition
on disk #1, the USB disk drive. If it is an NTFS partition, NAS users can open or
copy files from \\192.168.1.100\usbhdd\usb1\1 but cannot add new files or
modify existing files.

If you want to write to an USB storage device, the file system must be FAT32.

USB Storage FAT32 Partition NTFES Partition
Read OK OK
Write OK -

Replacing Damaged Hard Drives

If you are using RAID 1, you can easily replace a damaged hard drive in the
Thecus N299 while keeping your data secure with the system’s automatic data
recovery.

Hard Drive Damage

When a hard drive is damaged, its LED glows a steady red. If there is data in the
RAID volume, the system LED also glows red and the system beeps.
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Replacing a Hard Drive
To replace a hard disk drive in the N299:

1. Remove two screws located on the back of the unit using a Philips
screwdriver.

2. Unscrew four mounting screws.
3. Lift up the hard disk tray by pulling up the top panel of the N299.
4. Remove the damaged hard drive.

5. Carefully insert a standard 3.5” SATA hard disk into the tray, and secure
the hard disk with screws from the included accessory pack.

6. Carefully lower the hard disk tray back into the N299.

7. After making sure the tray is in place and the connectors are aligned,
secure the hard disk tray with screws.

RAID Auto-Rebuild

When using RAID 1 on the N299, you can use the auto-rebuild function when an
error is detected.

1. When a hard disk fails the system beeps and/or an email notification is
sent to specified receivers.

2. Check the hard disk LEDs to see which disk has failed.
3. Follow the steps mentioned above to replace the failed hard disk.

4. The system automatically recognizes the new hard disk and starts the
auto-rebuild sequence to resume its status before the hard disk crash.

Remote Administration

You can set up your N299 for remote administration. With remote administration,
you can access your N299 over the Internet, even if your N299 is behind a router.
This is especially useful if you are traveling and suddenly need a file from your
N299.

Setting up remote administration is a three-part process, and will require the
following equipment:

o Thecus N299 NAS device

o Cable/DSL Router with Dynamic DNS support
« Home PC

« Internet Connection

Router setup will differ slightly depending on router used. For this example, we will
NOTE use the Asus WL500g because it has support for Dynamic DNS. Contact your router
hardware vendor for setup help.

Part | - Setup a DynDNS Account
1. Go to http://www.dyndns.org from your home PC.

79



2. Click on the Sign Up Now link.

3. Check the Check boxes, select a user name (i.e.: N299), enter your email
address (i.e.: xxx@example.com), check Enable Wildcard, and create a
password (i.e.: XXxX).

4. Wait for an email from www.dyndns.org.

5. Open the email and click on the link to activate your account

Part Il - Enable DDNS on the Router

1. Go to the router setup screen and select IP Config > Miscellaneous
DDNS Setting from your Home PC.
2. Click on Yes for Enable the DDNS Client?
3. Select ww.dyndns.org.
4. Go to router setup screen, and enter the following information:
a. User Name or E-mail Address: xxx@example.com
b. Password or DDNS Key: xXxxXx
c. Host Name: www._N299.dyndns.org
d. Enable wildcard? Select Yes
e. Update Manually: Click Update

Part Il - Setting up Virtual Servers (HTTPS)

1. Navigate to NAT Setting > Virtual Server.
2. For Enable Virtual Server?, select Yes
3. Setup the HTTPS Server
a. Well-Known Applications: Select User Defined
b. Local IP: Enter 192.168.1.100
c. Port Range: 443 (the default HTTPS port setting on the N299)
d. Protocol: select TCP
e. Click Add.
f. Click Apply.
4. Test the HTTPS connection from another computer on the Internet

a. From a remote computer, open your browser and enter
https://www_N299._dyndns.org

b. You should see the login page of N299.

Firewall Software Configuration

If you are using a software firewall (i.e. Norton Internet Security) and are having
trouble connecting to the N299, you can try the following steps:

1. Double click the NIS icon on system tray, and then configure the
Personal Firewall.

2. On the Programs page, find the SetupWizard.exe and change its
permission to "Permit All". If it's not in the program list, use the Add or
Program Scan buttons to find it.

3. On the Networking page, manually add N299 IP address (i.e.
192.168.1.100) to the Trusted list.
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Chapter 7: Troubleshooting Guide
N299 Won't Turn On

In the event that the N299 won’t turn on, check to see that the power cable is
correctly plugged in to the N299. Also check to see if the electrical outlet is
functioning.

Resetting NAS IP Address and Admin Password

If you've forgotten the admin password, or if you need to reset the unit’s IP
address, first make sure that the unit is powered off. press the reset button and
the power button at the same time. keep pressing the reset button for 15
seconds then release it. When you hear the beep sound, the rebooting process is
completed. After that, the N299's WAN IP address will be reset to 192.168.1.100
temporarily. Please note that all file services at this time will be stopped.

1. When you point your browser to 192.168.1.100, you will see the following
screen.

2. If you select Reset to Factory Default option, the system will be reset.
Below are the default system settings:
Admin password > admin
WAN IP address > 192.168.1.100
WAN IP Gateway »> 192.168.1.1
WAN Jumbo Frame Support -> OfF
LAN IP > 192.168.2.254
LAN Jumbo Frame Support > Off
HTTP Port -> 80
HTTPS port > 443

Forgot My Network IP Address

If you forget your network IP address and have no physical access to the system,
you can use the setup wizard to retrieve the IP of your N299.

1. Start the Setup Wizard, and it will automatically detect all Thecus IP
storage products on your network.

2. You should be able to find the IP address of the N299 which you have
forgotten in the Device Discovery screen.

Can't Access N299 from the LAN

If you cannot access the N299 from the LAN, make sure that its network cable is
correctly plugged in. Also, check to see if the N299's WAN and LAN settings are
configured correctly.

Can't Map a Network Drive in Windows XP

You may have problems mapping a network drive under the following conditions:
1. The network folder is currently mapped using a different user name and

password. To connect using a different user name and password, first
disconnect any existing mappings to this network share.

81



2. The mapped network drive could not be created because the following
error has occurred: Multiple connections to a server or shared
resource by the same user, using more than one user name, are
not allowed. Disconnect all previous connections to the server or shared
resource and try again.

To check out existing network connections, type net use under the DOS prompt.

N299 Chassis Feels Hot

The N299 uses its chassis to dissipate heat, and feeling warm to the touch is
completely normal. As such, make sure that the N299 is left in a well-ventilated
area to avoid overheating the unit.

Can’t Find Printer Server / Media Server / Download Manager

To use these functions, you must first install their respective modules. Once
installed, these will appear on the Main Menu. For installation instructions, refer
to the sections below:

Chapter 4: Additional Feature Setup> Media Server Module Installation
Chapter 4: Additional Feature Setup> Download Manager Module Installation

Chapter 4: Additional Feature Setup> Printer Server Module Installation

Restoring Factory Defaults

From the System menu, choose the Factory Default item and the Reset to
Factory Default screen appears. Press Apply to reset the N299 to factory
default settings.

Resetting to factory defaults will not erase the data stored in the hard disks, but
WAR N I NG WILL revert all the settings to the factory default values.

Problems with Time and Date Settings

The administrator is able to select an NTP Server to keep the N299’s time
synchronized. However, if the N299 can not access the Internet, you may
encounter a problem when setting the Time and Time Zone. If this happens:

1. Login to the Web Administration Interface.

2. Navigate to System > Time.

3. Under NTP Server, select No.

4. Set the Date, Time, and Time Zone.

5. Click Apply.
In addition, if the N299 is able to access the Internet and you want to keep the
NTP Server clock. isc.org by default, please make sure the DNS Server is

correctly, thereby allowing the NTP Server name to correctly resolve. (See
Network > LAN 1 > DNS Server)
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Simple Problem Diagnosis Procedure

This procedure is meant to provide a simple and quick way to identify which part
of the N299 has failed.

1.

Don’t insert a hard disk into the N299. Attach the power cord and then
reset the IP address and admin password to the default settings by doing
the following:
a) Power on the N299 and immediately press the Reset button for 10
seconds. (The Reset button is near the LAN connector)
b) This resets the N299 to its default IP address and password
settings.
o Default IP: 192.168.1.100
« Default admin password: admin

Attach the power cord and connect the LAN cable between the N299 and a
PC. Don’t use a hub.

Turn on the N299 and check the front panel. The Power LED should glow
blue after power button is pressed. Then, the Busy LED starts blinking
orange for around 60 seconds. After that, the Busy LED turns off. If the
Busy LED keeps blinking orange for more than 3 minutes, the firmware
may be corrupted during improper firmware upgrade procedures. It means
that the motherboard has malfunctioned and needs to be repaired.

Set the IP address of the PC as 192.168.1.111, and then access the
Login page. Make sure the N299 and the PC is directly connected through
a LAN cable, and not through a hub or a router.

Check if the Web Administration Interface shows up and works fine. Then,
check if the system status is normal and the HDD Power LED works fine.
If the results are positive, it means that the N299 is functioning normally.
Otherwise, the N299 may be damaged.

Suppose that the N299 has been damaged. If the Power LED glows blue
and both system and power fans work fine after power button pressed, the
motherboard needs to be checked and repaired. Otherwise, the power
supply unit has problems.
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Appendix A: Product Specifications

Hardware Specifications

Core Processors / Memory

Processor StorLink SL3516 32-bit SoC
SATA Controller Integrated into Processor
NOR Flash 16MB
Memory 128MB
Network Interfaces
WAN 1 x 10/100/1000 Mbps Ethernet Port
LAN 1 x 10/100/1000 Mbps Ethernet Port

Wireless (optional)

IEEE 802.11b/g AP mode (using approved USB Dongles)

Storage

HDD Bays 2 x3.5" SATAHDD
HDD Capacity 80/120/160/200/250/300/400/500GB
USB 2.0 USB 2.0 ports for easy storage expansion
10 Interfaces
| UsB | 2 x USB 2.0 port

System Information

LED Indicators

1 x Power LED

1 x System Busy LED
2 x Network LED

2 X HDD Activity LED

Buzzer System alert
Physical

Width 160 mm

Height 85 mm

Depth 200 mm

Security Kensington Lock

Power Supply

External Adaptor

Switching power supply
Input: AC 100 ~ 240 Volt, 50/60 Hz
Output: DC 12V

Environment

Temperature

5 °C to 40 °C (Operating)

Humidity

0 ~ 80 % R.H. Non-condensing

Safety and Environment

CE, FCC, BSMI, C-Tick, RoHS Compliant

Software Specifications

Network

Configuration

Fixed IP address, dynamic IP address, PPPoE, DDNS

Network File Protocols

Microsoft Networks (CIFS/SMB )
Apple Filing Protocol (AFP 3)
Network File System (NFS v3)
File Transfer Protocol (FTP)
WebDisk (HTTP/HTTPS)

Client Platform Support

Windows NT /2000 / XP / 2003 / Vista
UNIX / Linux / BSD
Apple OS X/9/8.6

DHCP Server

Assigning IP addresses on WAN / LAN / WLAN ports

Print Server

Network printing through Internet Printing Protocol (IPP)

Download Manager

Supports BT, FTP, HTTP scheduled downloads

Disk Management

RAID Levels

0,1,JBOD

Auto Rebuild

Rebuild new hard drives while inserting to an existing RAID system

Power Management
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| Fan

| Thermally-controlled system fan

Multimedia Support

Media Server

Supports uPnP AV streaming protocol

iTunes Server

Supported File Types: AAC, MP3, WAV

Photo Web Server

Supported File Types: GIF, JPG (JPEG), BMP, PNG
Supports EXIF display
Supports slide show

Simple Surveillance
Server

Supports image capture, scheduling

Share Management

User Authentication

Supports built-in user accounts and groups

Folder Management

Share Folder Level Permission
Public Folder

Permission Management

Read/Write, Read Only or Deny options on individual users or groups

=

le System

File System Type

Journaling File System

Language Support

Multilingual support

System Management

Web-based
Administration

Multilingual support
English, French, German, Italian, Spanish, Traditional Chinese,
Simplified Chinese, Korean, and Japanese

Setup Wizard

MS Windows discovery and setup utility program

Email Notification

Send system message via Email to specified Email accounts

Backup

Thecus Backup Program

Thecus Backup Utility (Client backup utility; supports Microsoft
Windows XP/2000/MAC OS X)

** For supported USB dongles, please contact sales@thecus.com
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Appendix B: Customer Support

If your N299 is not working properly, we encourage you to check out Chapter 7:
Troubleshooting Guide, located in this manual. You can also try to ensure that
you are using the latest firmware version for your N299. Thecus is committed to
providing free firmware upgrades to our customers. Our newest firmware is
available on our Download Center:

http://www.thecus.com/download.php

If you are still experiencing problems with your N299, or require a Return
Merchandise Authorization (RMA), feel free to contact technical support via our
Technical Support Website:

http://www.thecus.com/support_tech.php

Customers in the US should send all technical support enquiries to this email
address:

support-us@thecus.com

If you would rather receive support over the phone, you can contact Thecus FAE
Support at:

+886-2-26981788

Please note that our headquarters are in Taipei, Taiwan, and our office hours are
Monday to Friday, 9:00 to 17:00.

For Sales Information you can e-mail us at:

sales@thecus.com

Thank you for choosing
Thecus!

Thecus’
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Appendix C: RAID Basics

Overview

A Redundant Array of Independent Disks (RAID) is an array of several hard disks
that provide data security and high performance. A RAID system accesses several
hard disks simultaneously, which improves 1/0 performance over a single hard
disk. Data security is enhanced by a RAID, since data loss due to a hard disk
failure is minimized by regenerating redundant data from the other RAID hard
disks.

Benefits

RAID improves 1/0 performance, and increases data security through fault
tolerance and redundant data storage.

Improved Performance

RAID provides access to several hard disk drives simultaneously, which greatly
increases 1/0 performance.

Data Security

Hard disk drive failure unfortunately is a common occurrence. A RAID helps
prevent against the loss of data due to hard disk failure. A RAID offers additional
hard disk drives that can avert data loss from a hard disk drive failure. If a hard
drive fails, the RAID volume can regenerate data from the data and parity stored
on its other hard disk drives.

RAID Levels

The Thecus N299 supports standard RAID levels O, 1, and JBOD. You choose a
RAID level when you create a system volume. The factors for selecting a RAID
level are:

e Your requirements for performance

e Your need for data security

e Number of hard disk drives in the system, capacity of hard disk drives in
the system

The following is a description of each RAID level:

RAID O

RAID O is best suited for applications that need high bandwidth but do not require
a high level of data security. The RAID O level provides the best performance of
all the RAID levels, but it does not provide data redundancy.

RAID O uses disk striping and breaking up data into blocks to write across all hard
drives in the volume. The system can then use multiple hard drives for faster
read and write. The stripe size parameter that was set when the RAID was
created determines the size of each block. No parity calculations complicate the
write operation.
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RAID 1

RAID 1 mirrors all data from one hard disk drive to a second one hard disk drive,
thus providing complete data redundancy. However, the cost of data storage
capacity is doubled.

This is excellent for complete data security.

JBOD

Although a concatenation of disks (also called JBOD, or "Just a Bunch of Disks") is
not one of the numbered RAID levels, it is a popular method for combining
multiple physical disk drives into a single virtual one. As the name implies, disks
are merely concatenated together, end to beginning, so they appear to be a
single large disk.

As the data on JBOD is not protected, one drive failure could result total data loss.

Stripe Size

The length of the data segments being written across multiple hard disks. Data is
written in stripes across the multiple hard disks of a RAID. Since multiple disks
are accessed at the same time, disk striping enhances performance. The stripes
can vary in size.

Disk Usage

When all 4 disks are of the same size, and used in RAID, the N299’s disk usage
percentage is listed below:

RAID Level Percentage Used
RAID O 100%
RAID 1 50%
JBOD 100%
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Appendix D: Licensing Information

Overview

This product included copyrighted third-party software licensed under the terms
of GNU General Public License. Please see THE GNU General Public License for
extra terms and conditions of this license.

Source Code Availability

Thecus Technology Corp. has exposed the full source code of the GPL licensed
software. For more information on how you can obtain our source code, please
visit our web site, http://www.thecus.com.

Copyrights

® This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com).

® This product includes software developed by Mark Murray.

® This product includes software developed by Eric Young
(eay@cryptsoft.com).

® This product includes software developed by the OpenSSL Project for use in
the OpenSSL Toolkit (http://www.openssl.org/).

® This product includes PHP, freely available from (http://www.php.net/).

® This product includes software developed by the University of California,
Berkeley and its contributors.

® This product includes software developed by Winning Strategies, Inc.

® This product includes software developed by the Apache Group for use in
the Apache HTTP server project (http://www.apache.org/).

® This product includes software developed by Softweyr LLC, the University
of California, Berkeley, and its contributors.

® This product includes software developed by Bodo Moeller.

® This product includes software developed by Greg Roelofs and contributors
for the book, "PNG: The Definitive Guide," published by O'Reilly and
Associates.

® This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

® This product includes software developed by Yen Yen Lim and North Dakota
State University.

® This product includes software developed by the Computer Systems
Engineering Group at Lawrence Berkeley Laboratory.

® This product includes software developed by the Kungliga Tekniska
Hogskolan and its contributors.

® This product includes software developed by the Nick Simicich.
® This product includes software written by Tim Hudson (tjh@cryptsoft.com).

® This product includes software developed by Christopher G. Demetriou for
the NetBSD Project.
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CGIC License Terms
Basic License

CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by
Thomas Boutell and Boutell.Com, Inc.

Permission is granted to use CGIC in any application, commercial or
noncommercial, at no cost. HOWEVER, this copyright paragraph must appear on
a "credits" page accessible in the public online and offline documentation of the
program. Modified versions of the CGIC library should not be distributed without
the attachment of a clear statement regarding the author of the modifications,
and this notice may in no case be removed. Modifications may also be submitted
to the author for inclusion in the main CGIC distribution.

GNU General Public License
Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

PREAMBLE

The licenses for most software are designed to take away your freedom to share
and change it. By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users. This General Public License applies to most of
the Free Software Foundation's software and to any other program whose authors
commit to using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish), that
you receive source code or can get it if you Want it, that you can change the
software or use pieces of it in new free programs; and that you know you can do
these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights. These restrictions translate
to certain responsibilities for you if you distribute copies of the software, or if you
modify it.

For example, if you distribute copies of such a program, whether gratis or for a
fee, you must give the recipients all the rights that you have. You must make
sure that they, too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer

you this license which gives you legal permission to copy, distribute and/or
modify the software.
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Also, for each author's protection and ours, we Want to make certain that
everyone understands that there is no warranty for this free software. If the
software is modified by someone else and passed on, we Want its recipients to
know that what they have is not the original, so that any problems introduced by
others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish
to avoid the danger that redistributors of a free program will individually obtain
patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone's free use or
not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License. The "Program”, below, refers to any such
program or work, and a "work based on the Program" means either the
Program or any derivative work under copyright law: that is to say, a work
containing the Program or a portion of it, either verbatim or with modifications
and/or translated into another language. (Hereinafter, translation is included
without limitation in the term "modification”.) Each licensee is addressed as

you".

Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope. The act of running the Program is not
restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made
by running the Program).

Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such
modifications or work under the terms of Section 1 above, provided that you
also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that
you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in
part contains or is derived from the Program or any part thereof, to be
licensed as a whole at no charge to all third parties under the terms of this
License.
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c) If the modified program normally reads commands interactively when run,
you must cause it, when started running for such interactive use in the
most ordinary way, to print or display an announcement including an
appropriate copyright notice and a notice that there is no warranty (or else,
saying that you provide a warranty) and that users may redistribute the
program under these conditions, and telling the user how to view a copy of
this License. (Exception: if the Program itself is interactive but does not
normally print such an announcement, your work based on the Program is
not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable
sections of that work are not derived from the Program, and can be
reasonably considered independent and separate works in themselves, then
this License, and its terms, do not apply to those sections when you distribute
them as separate works. But when you distribute the same sections as part
of a whole which is a work based on the Program, the distribution of the whole
must be on the terms of this License, whose permissions for other licensees
extend to the entire whole, and thus to each and every part regardless of who
wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to
work written entirely by you; rather, the intent is to exercise the right to
control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with
the Program (or with a work based on the Program) on a volume of a storage
or distribution medium does not bring the other work under the scope of this

License.

You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1
and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source
code, which must be distributed under the terms of Sections 1 and 2 above on
a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give
any third party, for a charge no more than your cost of physically performing
source distribution, a complete machine-readable copy of the corresponding
source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to
distribute corresponding source code. (This alternative is allowed only for
noncommercial distribution and only if you received the program in object
code or executable form with such an offer, in accord with Subsection b
above.)

The source code for a work means the preferred form of the work for making
modifications to it. For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface

definition files, plus the scripts used to control compilation and installation of
the executable. However, as a special exception, the source code distributed
need not include anything that is normally distributed (in either source or

binary form) with the major components (compiler, kernel, and so on) of the
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operating system on which the executable runs, unless that component itself
accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even
though third parties are not compelled to copy the source along with the
object code.

You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the
Program or its derivative works. These actions are prohibited by law if you do
not accept this License. Therefore, by modifying or distributing the Program
(or any work based on the Program), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying, distributing or
modifying the Program or works based on it.

Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to copy,
distribute or modify the Program subject to these terms and conditions. You
may not impose any further restrictions on the recipients' exercise of the
rights granted herein. You are not responsible for enforcing compliance by
third parties to this License.

If, as a consequence of a court judgment or allegation of patent infringement
or for any other reason (not limited to patent issues), conditions are imposed
on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this
License. If you cannot distribute so as to satisfy simultaneously your
obligations under this License and any other pertinent obligations, then as a
consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then the only
way you could satisfy both it and this License would be to refrain entirely from
distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices. Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose
that choice.
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10.

11.

12.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

If the distribution and/or use of the Program is restricted in certain countries
either by patents or by copyrighted interfaces, the original copyright holder
who places the Program under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make
exceptions for this. Our decision will be guided by the two goals of preserving
the free status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF
ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS
OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED
BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE
WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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	Chapter 1: Introduction
	Overview

	Thank you for choosing the Thecus N299 IP Storage Server. The Thecus N299 is an easy-to-use storage server that allows a dedicated approach to storing and distributing data on a network. Data reliability is ensured with RAID features that provide data security and recovery. Two Gigabit Ethernet ports enhance network efficiency, allowing the N299 to take over file management functions. The N299’s user-friendly GUI supports multiple languages, and its built-in media server and optional wireless connectivity via USB dongles allow users to share and enjoy their digital media in virtually any room of the house.
	Product Highlights
	File Server


	First and foremost, the N299 allows you to store and share files over an IP network. With a Network Attached Storage (NAS) device, you can centralize your files and share them easily over your network. With the easy-to-use web-based interface, users on your network can access these files in a snap.
	To learn about the Web User Interface, go to Chapter 5: Using the N299 > Web User Interface.
	Media Server

	The N299 can also act as a convenient media server, allowing you to enjoy and share photos, music, and movies via the uPnP AV streaming protocol. 
	To set up the Media Server, refer to Chapter 4: Additional Feature Setup > Media Server.
	FTP Server

	With the built-in FTP Server, friends, clients, and customers can upload and download files to your N299 over the Internet with their favorite FTP programs. You can create user accounts so that only authorized users have access. 
	To set up the FTP Server, refer to Chapter 4: Additional Feature Setup > FTP Server.
	iTunes® Server

	Digital music is one of the hottest trends, and with the built-in iTunes® server, you can share your digital music files with every iTunes-equipped PC on your network. The iTunes Server is also incredibly easy to set up! 
	To set up the iTunes Server, refer to Chapter 4: Additional Feature Setup > iTunes Server.
	Photo Gallery

	Got a lot of photos? Share them effortlessly with the N299’s built-in Photo Gallery. Users can create albums and upload photos in a snap, and the N299 will even auto-create thumbnails.
	To find out how to share photos with the N299, refer to Chapter 5: Using the N299 > Using Photo Gallery.
	Backup Server

	Don’t leave precious data to chance. With advanced backup capabilities, you can easily upload mission critical files to the N299, and even automate your backup tasks for true peace-of-mind.
	To find out how to backup your files with the N299, refer to Chapter 5: Using the N299 > File Backup.
	Download Manager

	Tired having downloads take up all of your bandwidth when you need it most? With the N299’s Download Manager, you can let the N299 complete your BT, HTTP, and FTP during off-peak hours. With the N299 lower power requirements, you can even save money off your monthly power bill.
	To set up the Download Station, refer to Chapter 4: Additional Feature Setup > Download Manager.
	Printer Server

	With the N299’s Printer Server, you can easily share an IPP printer with other PCs connected to your network. 
	To set up the Printer Server, refer to Chapter 4: Additional Feature Setup > Printer Server.
	IP Cam Surveillence Server

	Keep an eye on things with the built-in IP Cam Surveillence Server. Just plug in a compatible webcam and the N299 can send snapshots to an account that you specify. Best of all, your PC doesn’t even have to be turned on! 
	To set up the IP Cam Surveillence Server, refer to Chapter 4: Additional Feature Setup > IP Cam Surveillence.
	Package Contents

	Your N299 package should contain the following items:
	 Thecus N299 NAS Device
	 Accessory Pack:
	o Power cord
	o RJ-45 Ethernet cable
	o hard disk screws
	o hard disk tray screws
	o Installation CD
	o Quick Installation Guide
	o Warranty card
	Please check to see if your package is complete. If you find that some items are missing, contact your dealer.
	Front Panel

	The N299’s front panel displays the unit’s array of status LEDs, and is also where you’ll find the power button and USB port. See the table below for a detailed explanation of each: 
	Rear Panel

	The rear panel of the N299 houses the USB and Ethernet connections, as well as the power connector. See the table below for descriptions of each:
	Chapter 2: Getting Started
	Overview

	Your N299 is designed for complete ease-of-use. To help you get started, the following chapter will help you get your N299 up and running in no time. Please read it carefully to prevent damaging your unit during installation.
	Before You Begin

	Before you begin, be sure to take the following precautions:
	1. Read and understand the Safety Warnings outlined in the beginning of the manual.
	2. If possible, wear an anti-static wrist strap during installation to prevent static discharge from damaging the sensitive electronic components on the N299.
	3. Be careful not to use magnetized screwdrivers around the N299’s electronic components.
	4. The N299 uses its chassis to dissipate heat. Please leave your N299 in a well-ventilated area to prevent overheating.
	Hard Disk Installation

	The N299 supports standard 3.5” (SATA) hard disks. To install a hard disk into the N299, follow the steps below:
	1. Remove two screws located on the back of the unit using a Philips screwdriver. 
	2. Unscrew four mounting screws.
	3. Lift up the hard disk tray by pulling up the top panel of the N299.
	4. Carefully insert a standard 3.5” SATA hard disk into the tray, and secure the hard disk with screws from the included accessory pack.
	5. If you are installing two hard disks, please insert the second hard disk at the bottom of the tray and secure it with screws from the included accessory pack.
	6. Carefully lower the hard disk tray back into the N299. 
	7. After making sure the tray is in place and the connectors are aligned, secure the hard disk tray with screws. 
	Cable Connections

	Make the following connections on the Thecus N299 and then power up the unit:
	1. Connect an Ethernet cable from your network to the WAN port on the back panel of the N299.
	2. Connect the provided power cord into the universal power socket on the back panel. Plug the other end of the cord into a surge protected socket.
	3. Press the power button on the front panel to power on the N299.
	4. Make sure system is running properly by checking all front panel LEDs for any error indications.
	Installation Wizard

	The handy Thecus Setup Wizard makes configuring N299 a snap. To configure the N299 using the Setup Wizard, perform the following steps:
	1. Insert the installation CD into your CD-ROM drive (the host PC must be connected to the network).
	2. The Setup Wizard should launch automatically. If not, please browse your CD-ROM drive and double click on Setup.exe.
	3. Complete the Setup Wizard
	a. Device Discovery
	The Setup Wizard will start and automatically detect all Thecus Storage devices on your network. 
	b. Login
	Login into N299 with administrator’s account and password.
	c. Network Setting
	Name your N299 system and configure the network IP address. You can choose either fixed IP or DHCP.
	d. Change Admin Password
	e. Start Browser
	Access the current N299 administrator Web User Interface pressing the “Start Browser” button.
	f. RAID and FW installation
	Please config the RAID first then carry on with FW installation to complete setup procedure.
	First Time Setup

	Once the hardware is installed, physically connected to your network, and powered on, you can now configure the Thecus N299 so that it is accessible to your network users. Follow the steps below for initial software setup.
	Step 1: Initial Login

	Make sure your network is connected to the Internet and access the N299 Login webpage:
	1. Type in the default IP address http://192.168.1.100 in your browser’s address line. If you have changed the N299’s IP address, type this in instead.
	2. The Login screen appears. 
	3. To gain initial access to the system type in the factory default administrator user name and password, which are as follows:
	User Name:  admin
	Password: admin
	4. Press Login.
	5. The About screen from the Status menu appears showing product information.
	Step 2: System Check and Configuration

	Once logged in, you are greeted with the Web Administration Interface, where you can check the N299’s status, as well as configure its operating parameters.
	1. In the Status menu, choose the System item to go to the System Status screen. Check that the basic system information such as CPU loading and Fan RPM are all OK.
	2. In the Status menu, choose the Info item to go to the System Information screen. Change the System Description to describe your system and press Apply. This information appears on the Login page.
	3. In the System menu, choose the Administrator Password item. The screen that appears lets you change the administrator password for the system. Press Apply to confirm your settings. 
	4. In the System menu, choose the Time item and the Time screen appears. Set the date, time and time zone and press Apply.
	Step 3: Configure Network Settings

	After setting the N299’s basic configuration options, the next step is to configure its network settings.
	1. In the Network menu, choose the WAN item and the Network Configuration screen appears. 
	2. Set host name and specify the domain name.
	3. Enable DHCP for setting the IP automatically or Disable DHCP to enter your own IP settings.
	4. Repeat steps 2 and 3 for the LAN item under the Network menu to configure the LAN port.
	5. In the Network menu, choose the Service item and the Service Support screen appears. 
	6. Enable or Disable each protocol according to your requirements.  Press Apply to confirm the setting.
	For details on configuring your network settings, refer to Chapter 3: System Management > Network Management.
	Step 4: Select RAID Level

	Once the network is configured, you should then select the appropriate RAID level and build your RAID array.
	1. From the Storage menu choose RAID item and the RAID Information screen appears. Press the Config button and the RAID Configuration screen appears. 
	2. Select your desired RAID mode.
	3. Check the hard disks you wish to create a RAID on. Specify a stripe size—64K is a normal setting. 
	4. Press the Create button to build the RAID storage volume. Configuring RAID is usually only required for initial setup. 
	Step 5: Create Local Users and Groups

	After your RAID is built, you can begin to create local users and groups for the N299.
	1. From the Accounts menu, choose Users item and the Local User Configuration screen appears. Click Add to add a new user.
	2. Enter a name and password for each user in the Name and Password boxes and re-enter the password in the Confirm Password box.
	3. Press the Apply button for each user and they will be added to the user list.
	4. From the Accounts menu, choose Groups item and the Local Group Configuration screen appears. Click Add to add a new group.
	5. Enter a group name in the Group Name box and click Apply to add the group to the group list.
	For more on managing users, go to Chapter 3: System Management > User and Group Management.
	Step 6: Create Folders and Set Up ACLs

	Once users are introduced into your network, you can begin to create various folders on the N299 and control user access to each using Folder Access Control Lists. 
	1. From the Storage menu, choose the Folder item and the Folder screen appears. Press the Add button and the Add Folder screen appears.
	2. Enter the name and description of the folder and choose whether it is browseable. Press Apply to create the folder.
	3. On the Folder screen press ACL (Access Control List) to configure which users have access to this folder. 
	4. On this screen, configure access to this folder for users and groups. Select a user or a group from the left hand column and then choose Deny Access, Read Only, or Writable to configure their access level. Press Apply to confirm settings. 
	For more information on managing folders, see Chapter 3: System Management > Storage Management > Folder Management.
	To find out about configuring Folder Access Control Lists, see Chapter 3: System Management > Storage Management > Folder Management > Folder Access Control List (ACL).
	Step 7: Start Services

	Finally, you can start to setup the different services of the N299 for the users on your network. You can find out more about each of these services by clicking below:
	Windows Networking   Media Server
	Apple File Protocol (AFP)   Download Manager
	FTP Server     Printer Server
	iTunes® Server    IP Cam Surveillance Server
	Photo Gallery
	Overview

	The N299 provides an easily accessible web management interface. With it, you can configure and monitor the N299 anywhere on the network.
	Web Administration Interface

	Make sure your network is connected to the Internet. To access the N299 Login Page:
	1. Type the N299’s IP address into your browser. (Default IP address is http://192.168.1.100)   
	2. Login to the system using the administrator user name and password. The factory defaults are: 
	User Name: admin
	Password: admin
	If you changed your password in the setup wizard, use the new password.
	Once you are logged in as an administrator, you will see the Web Administration Interface. From here, you can configure and monitor virtually every aspect of the N299 from anywhere on the network.
	Menu Bar

	The Menu Bar is where you will find all of the information screens and system settings of the N299. The various settings are placed in the following groups on the menu bar:
	Clicking on any of these items will display the dropdown menu selections for each group.
	In the following sections, you will find detailed explanations of each function, and how to configure your N299.
	Language Selection

	The N299 supports multiple languages. On the menu bar, click Language and the Change Language screen appears. This screen allows you to select preferred language for the N299. The N299’s interface supports the following languages:
	 English
	 Simplified Chinese
	 Traditional Chinese
	 German
	 French
	 Italian
	 Japanese
	 Korean
	 Spanish
	Press Apply to confirm your selection.
	Language Package Upload and Management

	You can also upload additional language packs as they become available. To do this, press Upload and the Language Package Upload/Management and User Upload Language Package List screens appear.
	To upload a language package, click Browse and browse for the language package location. Select the language package file and click Open. Then, click Apply to upload the language package to the N299. Once uploaded, the language package will appear in the User Upload Language Package List.
	Status Menu

	The Status Menu on the menu bar allows you to see various aspects of the N299. From here, you can discover the status of the N299, and even find out other details like firmware version and up time. 
	Product Information

	Once you login, you will first see the basic Product Information screen providing Manufacturer, Product No., Firmware Version, and Up Time information.
	To access this screen again, navigate to Status > About.
	System Status

	From the Status menu, choose the System item, and the System Status screen appears. This screen provides basic system status information.
	System Information

	From Status menu, choose the Info item, and the System Information screen appears. You can change the system information that appears on uPnP devices screens (i.e. Network Neighborhood) on Windows-based systems by entering the new information here and pressing Apply to confirm.
	Printer Status

	From the Status menu, choose the Printer item, and the Printer Information screen appears. The Printer Information screen provides the following information about the USB printer connected to the USB port.
	If a corrupt print job is sent to a printer, printing may suddenly fail. If your print jobs seem to be locked up, pressing the Remove All Documents button to clear the print queue may resolve the issue.
	For information on how to set up the Printer Server, refer to Chapter 4: Additional Feature Setup > Printer Server.
	Storage Management

	The Storage Menu displays the status of storage devices installed or connected to the N299, including disk and RAID information. 
	Disk Information

	From the Storage menu, choose the Disks item and the Disk Information screen appears. From here, you can see various items about installed SATA hard disks. Blank lines indicate that a SATA hard disk is not currently installed in that particular disk slot. 
	RAID Information

	From the Storage menu, choose the RAID item and the RAID Information screen appears. 
	To configure your RAID settings, press the Config button to go to the RAID Configuration screen.
	RAID Configuration

	On the RAID Information screen, press the Config button to go to the RAID Configuration screen. In addition to RAID disk information and status, this screen lets you make RAID configuration settings. 
	For more information on RAID, see Appendix C: RAID Basics.
	RAID Level

	You can set the storage volume as either None, JBOD, RAID 0, or RAID 1. RAID configuration is usually required only when you first set up the device. A brief description of each RAID setting follows:
	Disk Settings

	Using Disk Settings, you can select stripe size, choose which disks are RAID disks.
	Creating a RAID

	To create a RAID volume, follow the steps below:
	1. On the RAID Configuration screen, set the RAID storage space as JBOD, RAID 0, or RAID 1 — see Appendix C: RAID Basics for a detailed description of each.
	2. Tick the checkboxes of the hard disks you wish to use to create a RAID. 
	3. Specify a stripe size — 64K is the default setting. 
	4. Press Create to build the RAID storage volume.
	Deleting a RAID

	To delete a RAID volume, follow the steps below:
	1. On the RAID Configuration screen, click Remove.
	2. The system automatically removes the RAID volume and you can create a new RAID. 
	Folder Management

	From the Storage menu, choose Folder, and the Folder screen appears. This screen allows you to create and configure folders on the N299 volume. 
	Adding Folders

	On the Folder screen, press the Add button and the Add Folder screen appears. This screen allows you to add a folder. After entering the information, press Apply to create new folder. Press Back to return to the Folder screen. 
	Editing Folders

	On the Folder screen, press the Edit button and the Edit Folder screen appears. This screen allows you to change folder information. After entering the information, press Apply to apply the changes. Press Back to return to the Folder screen. 
	Deleting Folders

	To delete a folder, press the Del button from the specified folder row. The system will confirm folder deletion. Press OK to delete the folder permanently or Cancel to go back to the folder list.
	Folder Access Control List (ACL)

	On the Folder screen, press the ACL button, and the Folder Access Control List (Folder ACL) screen appears. This screen allows you to configure access to the specific folder for users and groups. Use the Read only, Writable, Deny access, or Unset radio buttons to configure access levels for listed users and groups. Press the Apply button to confirm your settings. 
	Service Folders

	The N299 automatically creates folders for its built-in applications. 
	To manage these service folders, select Service Folder from the Storage menu. Press NFS to setup access privilege. Press Edit to edit these folders. Press ACL to control access to these folders via the Access Control List. 
	Network Management

	Use the Network menu to make network configuration settings as well as service support settings.
	WAN Configuration

	From the Network menu, choose WAN, and the WAN Configuration screen appears. This screen displays the network parameters of the WAN connection. You may change any of these items and press Apply to confirm your settings. You can see a description of each item in the following table: 
	LAN Configuration

	The N299 supports a second Ethernet port for higher service availability. To configure these ports, choose LAN from the Network menu, and the LAN Configuration screen appears. Press Apply to save your changes. 
	DDNS Configuration

	The N299 also features Dynamic DNS support. To configure DDNS, choose DDNS from the Network menu. Press Apply to confirm your settings.
	WLAN Configuration

	When a compatible wireless USB dongle is installed on the N299, the N299 will become an access point, and the Network dropdown menu will contain a WLAN menu item. From the Network menu, choose WLAN, and the WLAN Configuration screen appears. This screen displays the wireless network parameters of the system. You can to change any of these items and press Apply to confirm your settings. 
	Web Services Configuration

	From the Network menu, choose the Services item, and the Web Service screen appears. This screen displays the service support parameters of the system. You can change any of these items and press Apply to confirm your settings. A description of each item follows: 
	Windows Network Configuration (SMB/CIFS)

	The N299 can act as a Samba server, enabling users to share files using the SMB/CIFS protocol. From the Network menu, choose the SMB/CIFS item, and the SMB/CIFS screen appears. You can change any of these items and press Apply to confirm your settings. A description of each item follows: 
	Apple Network Setup

	From the Network menu, choose the Apple Network item, and the Apple Network Configuration screen appears. This screen displays the configuration items for the Apple Filing Protocol. You can change any of these items and press Apply to confirm your settings. A description of each item follows: 
	NFS Setup

	From the Network menu, choose the NFS item, and the NFS server setting screen appears. The N299 can act as a NFS server, enabling users to download and upload files with their favorite NFS clients. Make your changes, and then click Apply to save them. Click Cancel to return to the main menu.
	User and Group Management

	The N299 has built-in user database that allows administrators to manage user access using different group policies. From the Accounts menu, you can create, modify, and delete users, and assign them to groups that you designate. 
	Local User Configuration

	From the Accounts menu, choose the Users item, and the Local User Configuration screen appears. This screen allows you to Add, Modify, and Delete local users. 
	You can quickly find a particular user name by clicking one of the letter groupings at the top of the window. For example, to find a user name beginning with the letter M, click the MNO user group, and the user names beginning with M, N, or O will be listed. To see all names, click ALL.
	Adding Users

	1. Click on the Add button on Local User Configuration screen, and Add NEW Local User screen appears.
	2. Enter a name in the User Name box.
	3. Enter a password in the Password box and re-enter the password in the Confirm Password box.
	4. Select which group the user will belong to. The Owner Group list is a list of groups this user belongs to. The Unjoined Group list is a list of groups this user does not belong to. Use the << or >> buttons to have this user join or leave a group.
	5. Press the Apply button and the user is created.
	Modifying Users

	Select an existing user from the Local User Configuration screen.
	2. Click on the Modify button, and Local User Setting screen appears.
	3. From here, you can enter a new password and re-enter to confirm, or use the << or >> buttons to have this user join or leave a group. Click the Apply button to save your changes.
	Deleting Users

	1. Select an existing user from the Local User Configuration screen.
	2. Click on Delete button and the user is deleted from the system.
	Local Groups Configuration

	From the Accounts menu, choose the Groups item, and the Local Group Configuration screen appears. This screen allows you to Add, Modify, and Delete local groups. 
	You can quickly find a particular group by clicking one of the letter groupings at the top of the window. For example, to find a user name beginning with the letter M, click the DEF letter group, and the groups beginning with M, N, or O will be listed. To see all groups, click ALL.
	Adding Groups

	1. On the Local Group Configuration screen, click on the Add button.
	2. The Add NEW Local Group screen appears.
	3. Enter a Group Name, and select users to be in this group from the Users List by adding them to the Members List using the << button. 
	4. Click the Apply button to save your changes. 
	Modifying Groups

	On the Local Group Configuration screen, select a group name from the list.
	2. Press the Modify button and the Local Group Setting screen appears.
	3. To add a user into a group, select the user from the Users List, and press the << button to move the user into the Members List.
	4. To remove a user from a group, select the user from Members List, and press the >> button.
	5. Click the Apply button to save your changes.
	Deleting Groups

	1. On the Local Group Configuration screen, select a group name from the list.
	2. Press Delete to delete the group from the system.
	System Management

	The System menu gives you a wealth of settings that you can use to configure your N299’s system administration functions. You can set up system notifications, view system logs, and even upgrade firmware from this menu.
	System Notifications

	From the System menu, choose the Notification item, and the Notification Configuration screen appears. This screen lets you have the N299 notify you in case of any system malfunction. Press Apply to confirm all settings. See following table for a detailed description of each item. 
	System Logs

	From the System menu, choose the Logs item and the System Logs screen appears. This screen shows a history of system usage and important events such as disk status, network information, and system booting. See the following table for a detailed description of each item: 
	Time and Date Settings

	From the System menu, choose the Time item and the Time screen appears. Set the desired Date, Time, and Time Zone. You can also elect to synchronize the system time on the N299 with an NTP (Network Time Protocol) Server. You can change any of these items and press Apply to confirm your settings. See the following table for a detailed description of each item: 
	System Configuration Backup and Restore

	From the System menu, choose the Config Mgmt item and the System Configuration Download/Upload screen appears. From here, you can download or upload stored system configurations. See the following table for a detailed description of each item. 
	Reset to Factory Default Settings

	From the System menu, choose the Factory Default item and the Reset to Factory Default screen appears. Press Apply to reset the N299 to factory default settings. Press Cancel to go back to the main menu. 
	Upgrading System Firmware

	From the System menu, choose the Firmware Upgrade item and the Firmware Upgrade screen appears. 
	Follow the steps below to upgrade your firmware:
	1. Use the Browse button to find the firmware file.
	2. Press Apply.
	3. The beeper beeps and the Busy LED blinks until the upgrade is complete.
	Change Administrator Password

	From the System menu, choose the Administrator Password item and the Change Administrator Password screen appears. Enter a new password in the New Password box and confirm your new password in the Confirm Password box. Press Apply to confirm password changes. See the following table for a detailed description of each item. 
	Reboot and Shutdown System

	From the System menu, choose Reboot & Shutdown item, and the Shutdown/Reboot System screen appears. Press Reboot to restart the system or Shutdown to turn the system off. 
	Logout

	To logout of the Web Administration Interface, navigate to System > Logout.
	Chapter 4: Additional Feature Setup
	Overview

	With a bevy of additional features and services, the N299 is so much more than a mere external hard disk. The sections below show you how you can utilize your N299 to serve files, music, movies, pictures, and more.
	FTP Server

	N299 can act as a FTP server, enabling users to download and upload files with their favorite FTP programs. From the Network menu, choose the FTP item, and the FTP screen appears. You can change any of these items and press Apply to confirm your settings. A description of each item follows: 
	To access the share folder on the N299, use the appropriate user login and password set up on the Users page (Accounts > Users). Access control to each share folder is set up on the ACL page (Storage > Folder > ACL).
	When trying to access N299 anonymously, just enter “anonymous” as the user name.
	iTunes® Server

	With the built-in iTunes server capability, the N299 enables digital music to be shared and played anywhere on the network! 
	From the Network menu, choose the iTunes item, and the iTunes Configuration screen appears. You may enable or disable the iTunes Service from here. Once enabled, enter correct information for each field and press Apply to save your changes. See the following table for detailed descriptions of each field: 
	Once the iTunes service is enabled, the N299 will make all music located in the Music folder available for iTunes-equipped computers on the network.
	Media Server

	With the built-in Media Server capability, the N299 provides media streaming service to stand-alone networked home media adapters that support the UPnP AV protocol. You can share digital media such as music, pictures, and movies with any compatible device throughout your entire home.
	Adding Media Share Folders

	Once the Media Server software is installed, you can start adding folders that contain the media that you would like to share. To create a media share folder, follow the steps below:
	1. Click on Network > Media Server in the menu bar. 
	2. Select the folder that contains your media files, and click the checkbox.
	3. The contents in the folder will be scanned for the Media Server. The time required for scanning depends on the size of the folder.
	Connecting DMAs to the Media Server

	Next, it’s time to connect your Digital Media Adapter (DMA) to the media server:
	1. Connect your DMA to your Media Server
	a. Configure your DMA to use a Dynamic IP address. The IP address will be assigned by the router.
	b. Some DMAs are wireless enabled. You can connect the DMA to a wireless router. For instructions on how to connect your DMA to a wireless router, please refer to your DMA’s user manual.
	2. Connect your DMA’s video output to video input of your TV set.
	3. Turn on the TV and change the video signal input to DMA.
	4. Setup the DMA (These steps will be different if you use a different DMA)
	a. From the Server List screen, select “N299:Mediabolic Server” as the server.
	b. Go to My Media
	c. Click on the Up/Down Arrow buttons to select Music Jukebox, Photo Albums, or Video Clips
	d. Start enjoying the contents stored in your N299.
	Download Manager

	With the built-in Download Manager, you can have the N299 download HTTP, FTP, and BT files without having full PC powered on. What’s more, you can even schedule your downloads for off-peak hours, ensuring efficient use of bandwidth. 
	Adding an HTTP Task

	To add a new HTTP task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select HTTP and click Add. 
	2. In the HTTP Task window, start by inputting the target URL in the Website URL box. This is the link to the download you want to queue.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. Select the maximum download bandwidth from the Max. Download Bandwidth dropdown.
	5. Press Apply to add the task.
	6. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	7. The following prompt will be shown when the download begins:
	8. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Adding an FTP Task

	To add a new FTP task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select FTP and click Add. 
	2. In the FTP Task window, start by inputting the target URL in the FTP File box. This is the link to the download you want to queue.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. The next step depends if you are using an anonymous login for your FTP download. If you are logging in anonymously, select Enable and move on to step 5.
	If you are required to login with a user name and password, set Anonymous FTP to Disable and input your user name and password into the appropriate fields. 
	5. Select the maximum download bandwidth from the Max. Download Bandwidth dropdown.
	6. Press Apply to add the task.
	7. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	8. The following prompt will be shown when the download begins:
	9. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Adding a BT Task

	To add a new BT task to the Download Manager, follow these steps:
	1. Using the Task Type dropdown, select BT and click Add. 
	2. In the BT Task window, start by clicking Browse… and selecting the torrent file you wish to start.
	3. Next, select the destination folder from the Destination Folder dropdown. This is where the download will reside.
	4. Next, you can designate the Sharing time after completion by selecting the number of hours from the dropdown.
	5. Next, you can select the maximum and minimum number of peers from selecting the counts from the appropriate dropdowns.
	6. Next, you can set the maximum download and upload bandwidths from the dropdowns below.
	7. Press Apply to add the task.
	8. Once added, your download will appear in the list of download tasks. To start the download, simply click the Start icon () and the download will begin.
	9. The following prompt will be shown when the download begins:
	10. The download status will continually update in the Download Tasks window. To pause the download, click the Pause icon (). 
	Deleting Tasks

	To delete a task, simply follow the steps below:
	1. Click the delete icon () beside the task that you wish to delete. The Delete Task dialogue box will appear.
	2. Select Delete Task only if you wish to remove only the torrent file and all transient files, leaving the unfinished download files intact.
	3. Select Delete Task and Files if you wish to remove the torrent file and all transient files, and the unfinished download files.
	4. Click OK to delete the task. Click Cancel to return to the Download Manager.
	Scheduling Downloads

	You can schedule your downloads to begin at different times of the day. This is useful if you wish to complete your downloads during off-peak hours, reserving your bandwidth for other applications. A table describing the Download Schedule window appears below:
	To schedule downloads, follow these steps:
	1. Under Download Schedule, set Scheduler to Enable.
	2. To schedule a daily download period, select Daily and select a start time and end time. 
	To schedule a weekly download period, select Weekly and select a start day/time and end time/day. 
	3. Click Apply to save your changes.
	Printer Server

	You can configure the N299 to act as a printer server. That way, all PCs connected to the network can utilize the same printer. From the Status menu, choose the Printer item, and the Printer information screen appears. To setup in either Windows XP or Vista, please refer the following for steps. 
	Windows XP SP2

	1. Connect the USB printer to one of the USB ports (preferably the rear USB ports; front USB ports can be used for external HDD enclosures).
	2. Go to Start > Printers and Faxes.
	3. Click on File > Add Printer.
	4. The Add Printer Wizard appears on your screen. Click Next.
	5. Select the “A network printer, or a printer attached to another computer” option.
	6. Select “Connect to a printer on the Internet or on a home or office network”, and enter “http://N299_IP_ADDRESS:631/printers/usb-printer” into the URL field.
	7. Your Windows system will ask you to install drivers for your printer. Select correct driver for your printer.
	8. Your Windows system will ask you if you want to set this printer as “Default Printer”. Select Yes and all your print jobs will be submitted to this printer by default. Click Next.
	9. Click Finish.
	Windows Vista

	To set up the Printer Server in Windows Vista, follow the steps below:
	1. Open Printer Folder from the Control Panel.
	2. Click the right mouse button in anywhere on the Printers folder and then select Add Printer.
	3. Select Add a network, wireless or Bluetooth printer.
	4. Select The printer that I want isn’t listed.
	You can press The printer that I want isn’t listed to go into next page without waiting for Searching for available printers to finish.
	5. Click Select a shared printer by name.
	Type http://<Thecus_NAS>:631/printers/usb-printer in the box, where <Thecus_NAS_IP> is the IP address of the N299. Click Next.
	6. Select or install a printer and then press OK.
	If your printer model is not listed, please contact your printer manufacturer for help.
	7. Windows will attempt to connect to the printer.
	8. You can choose to set this printer as the default printer by checking the Set as the default printer box. Click Next to continue.
	9. Done! Click Finish.
	IP Cam Surveillance

	With the Simple Surveillance Server, you can connect an IP cam to the N299 to capture images. The Simple Surveillance Server also supports scheduling, which means that you can configure the N299 to perform home surveillance at any time.
	From the Status menu, choose the IP Cam Surveillance item, and the IP Cam Surveillance Information screen appears. The IP Cam screen provides information and allows you to configure the Simple Surveillance Server.
	To designate a schedule for the Simple Surveillance Server, click Schedule, and the Schedule Configuration window will appear:
	IP Cam Configuration

	Setting up an IP Cam for use with the N299 is easy. In this example, we’ll setup a Vivotek PT7237 IP cam for use with the N299. Configuring a different IP cam will be slightly different depending on the model you are using, but this guide will outline the basics.
	Follow the instructions included with your IP cam for installation. Once your IP cam is properly installed, follow the steps below to configure your N299.
	Step 1: Connect the IP Cam to the N299

	The first step is to connect your IP cam to the N299. To do this, login to the N299’s Web Admin Interface and select IP Cam Surveillance from the menu. The IP Cam Surveillance window will appear. Here, we will connect your installed IP Cam to the N299.
	In this window, you will be asked to fill in some basic information about your IP camera. Let’s go through each field in order:
	Location: Here, you can designate a location that the IP cam is located. For example, if the IP cam is currently monitoring your office, you can enter “office” in the blank. Choose a name that is meaningful will make it easier to refer back in the future.
	URL: This is where the URL for your IP cam is entered. Every IP cam has a URL that is provided which links to a landing page for all captured images. In this example, the Vivotek PT7237 uses the following URL:
	http://172.16.66.95/cgi-bin/video.jpg
	Please refer to your IP cam manual for the appropriate URL to enter into this field.
	Interval: Here, you can designate the time between each captured image. Select the desired interval from the dropdown menu.
	Folder: Enter the name of the folder you wish the N299 to store captured images to.
	Once this information is entered, simply click Add.
	After clicking OK to the resulting prompt, your IP cam will appear in the IP Cam Surveillence window.
	Step 2: Designate a Capture Schedule

	Once connected, the next step is to create a capture schedule for your IP cam. To do this, enter the correct information into the Schedule window. 
	Let’s take a closer look at each field:
	Schedule Stat: To enable the scheduling function, click Enable.
	Frequency: Here, you can set the frequence of the schedule to either Daily or Weekly. When set to Daily, images will be captured every day at the designated time. When set to Weekly, you can have the IP camera capture images at certain days of the week (i.e Monday to Friday). 
	Start Time: Choose the start day and time for image capture. If you’ve selected a Daily frequency, you will be unable to select the start day as the IP camera will be set to capture images every day.
	End Time: Chosse the end day and time for image capture. If you’ve selected a Daily frequency, you will be unable to select the end day as the IP camera will be set to capture images every day.
	Once you are finished, click Apply to enable your new schedule.
	Step 3: Browse Captured Images

	Once the capture schedule has been set, you can browse the captured images on the N299. The easiest way to do this is to simply open the folder you previously designated as the capture directory and view your captured pictures using your favorite photo viewing software. In the example above, all captured images will appear in the IPCam folder.
	Alternatively, you may also use the built-in web-based Photo Gallery to view your pictures. For information on how to set up the Photo Gallery, check here.
	Chapter 5: Using the N299
	Overview

	Once the N299 is setup and operating, users on the network may manage all varieties of digital music, photos, or files by simply using their web browsers. To manage your personal files or access public files on the N299, just enter its IP address into your browser, and you will be taken to the N299 Login page.
	Login Page

	On the login page, simply enter your User ID and Password and click Login to log into the system.
	Once logged in, you will be seen the icons for WebDisk where you can see the directories and files stored on the N299.
	Using WebDisk

	1. From the WebDisk folder list, users will see all public folders and all folders which they have sufficient access rights.
	2. When they click on the name of a folder, they will be brought to the Folder Screen, where they will see the files within that folder. 
	3. When user clicks on a file name, the file will be downloaded.
	For more information on how to setup user rights to the folders, please check Chapter 3: System Management > Storage Management > Folder Management > Folder Access Control List (ACL) 
	To access folders with access control, you must first login with a local user account.
	Using iTunes® Server

	The N299 has a built-in iTunes® Server that allows you to stream music stored on the N299 to any iTunes-ready device on your network.
	You can use the WebDisk function to manage your digital music, or you can manage through SMB/CIFS (see SMB/CIFS Setup section).
	Adding Music Files

	You could add music files into iTunes Server through Web User Interface; however, if you have lots of folders and files to upload, there is a simpler way.
	1. Open a Windows Explorer and type the N299 IP address in the address bar (i.e. \\192.168.1.100).
	2. Double click the Music folder to enter it. Then drag and drop music folders and files here.
	3. The N299 iTunes server will take some time to cache the ID3 tag of every file. Once the process is done, you will see all the music files from iTunes clients.
	Playing Music Files

	Once your music files are added to the N299, playing them on any iTunes-equipped computer connected to the network is easy:
	1. Open iTunes.
	2. You should see Thecus_N299 under the SHARED heading in the left hand menu.
	3. Click Thecus_N299 and all shared music will be displayed, ready to be enjoyed right from iTunes.
	Using Photo Gallery

	Using the Photo Gallery, users can view and share photos, and even create their own albums right on the N299. To manage your photo gallery or see other photo albums, click on the Photos icon from the left panel.
	You will see your own Photo Gallery and all public Photo Albums on the network.
	To manage any picture files, you must first select the item by clicking its check box.
	Managing Albums and Photos
	Creating Albums

	To create a photo album, follow the steps below:
	1. Click the Add button to create a new album.
	2. Enter a name for the album, and enter a description if you wish. Then, click on the Create Album button.
	Password Protecting Albums

	If you would like to put a password on a particular album, follow these steps:
	1. Select the album to be protected, click on the Edit button, and the Album Edit screen will appear. 
	2. The owner of the album can enter an album password to protect the album, so that only people with the correct password can view the album. 
	Uploading Pictures to Albums

	Uploading pictures to albums using the Web User Interface is easy:
	1. When the album is created, click the album icon to enter the album. Initially the album is empty. 
	2. Click the Add button to upload pictures into the album. The Upload Photos screen will appear. Users can select and upload up to 8 pictures at a time.
	3. Once the picture is uploaded, you can view it in the album. 
	4. The owner of the album can delete or modify the pictures with the Delete or Modify buttons on the top right hand corner. 
	Windows XP Publishing Wizard

	There are many ways for a local user to upload pictures into their photo album. Users of Windows XP can upload their pictures using the Windows XP Publishing Wizard.
	1. Click on the XP Publishing Wizard icon.
	2. The XP Web Publishing Wizard Client screen appears. Click on the link to install the Publishing Wizard. 
	3. Windows XP will ask whether you want to run or save this file. Click Run.
	4. Once the Wizard is installed, use the Windows file manager to browse the folder that contains the picture you want to publish. On the left pane, there will be an icon labeled “Publish this folder to the Web”. 
	5. Click on this icon and Web Publishing Wizard will start. 
	6. Select the pictures you want to publish to the Photo Web Server by placing a check mark on the top left hand corner of the picture. Click Next. 
	7. Your PC will start to connect to the Photo Web Server.
	8. Select N299 Photo Gallery Wizard to publish your pictures to the N299. 
	9. Login into the N299 with your local user name and password.
	10. Create your album by entering an album name and clicking on the Create Album button. 
	11. Select the album you want to upload your pictures to.
	12. Confirm the target album. 
	13. Windows will show you that the picture upload is in progress.
	14. When the upload is finished, the Wizard will ask you whether if you want to go to the website. Click Finish to go to your Photo Web Server.
	15. Click on the user’s icon to go to that user’s album. 
	16. You will see the user’s album list. Click on MyAlbum. 
	17. Finished! You will see the pictures just selected in the album.  
	EXIF Information

	While viewing pictures, you can also have the N299 display the EXIF information for each photo.
	Slide Shows

	Slide shows are a great way to enjoy pictures stored on your N299. 
	You can click on the Start Slide Show icon on the top right hand corner to start the slide show.
	To stop the slide show, click on the Stop Slide Show icon on the top right hand corner. 
	File Backup

	There are a number of ways to back up your data to your N299. 
	Nsync

	You can backup a share folder to another N299 (Nsync Target) or any FTP server for safe keeping as long as you have appropriate access right on that target. When using Nsync between two N299s, you have the option to transmit files securely between two N299s. 
	If the files on your N299 are lost for any reason, you can restore those files from the target N299. To backup files regularly, you can set up a scheduled task to run only once, daily, weekly, or monthly. You can also limit the bandwidth of your Nsync tasks, so other users on the network can share the bandwidth equally.
	Under the Storage menu, click Nsync and the Nsync window appears. Below is a description of each field:
	Adding an Nsync Task

	From the Nsync Information screen, click Add to display the Add Nsync Task screen.
	Modifiying an Nsync Task

	On the Nsync window, select the Nsync task you would like to modify by checking its checkbox. Click Modify and the Modify Nsync Task window appears. 
	2. Change the settings for your Nsync task.
	3. Click Apply to save your settings.
	Deleting an Nsync Task

	1. On the Nsync window, select the Nsync task you would like to delete by checking its checkbox. 
	2. Click Delete to remove the selected Nsync task. 
	Setting Up an Nsync Target on an Nsync Device

	On the Nsync target server, the administrator of that server has to set up a user account with a folder named “nsync” and grant write access.
	1. On the Nsync server, add a user for Nsync source (ex. nsyncsource1). For instructions on how to add a user on the N299, see Chapter 4: System Management > User and Groups Management > Local User Configuration > Adding Users.
	2. On the Nsync server, grant that user (ex. nsyncsource1) write access to the nsync folder. For instructions on how to set up a folder’s ACL, see Chapter 4: System Management > Folder Management > Folder Access Control List (ACL).
	3. Once this is done, the target server will start accepting Nsync tasks from server using that ID and password.
	Setting Up an Nsync Target on Another Device

	If you selected “Other Device” when setting up your Nsync task, the N299 will use the FTP protocol to back up the share folder. On the external storage device, make sure there is a folder named “nsync”, and the Auth ID has writable permission in that folder.
	Designating N299 as an Nsync Target

	The N299 can act as an Nsync server, enabling another Nsync-equipped Thecus NAS at a remote location backup their files to this N299. From the Network menu, choose the Nsync Target item, and the Nsync Target Server Setting screen appears.
	Thecus Backup Utility

	The Thecus Backup Utility is on your Installation CD. When you click on the CD, the Backup Utility will be installed under Program Groups > Thecus > Thecus Backup Utility. If it is not installed, you can copy the file (Thecus Backup Utility.exe) to a convenient location on your hard disk and double click to execute it.
	When you execute this utility for the first time, it will ask you whether to create a DB file. Click Yes.
	1. Click Add to create a Backup task. The Add New Task dialog box appears. 
	2. To schedule the task to run at regular intervals, click on the Schedule icon for that task. You can schedule the task to run Monthly or Weekly. 
	3. To check the log for that task, click on the Log icon for that task.
	Windows XP Data Backup

	If you use Windows XP Professional, you can also use the Windows Backup Utility (Ntbackup.exe) to backup your files.
	If you use Windows XP Home Edition, follow these steps to install the utility:
	1. Insert the Windows XP CD into a drive and double-click the CD icon in My Computer.
	2. When the Welcome to Microsoft Windows XP screen appears, click Perform Additional Tasks. 
	3. Click Browse this CD. 
	4. In Windows Explorer, navigate to ValueAdd > Msft > Ntbackup. 
	5. Double-click Ntbackup.msi to install the backup utility.
	Once installed, you can use the Windows Backup Utility by following the steps below:
	1. Click Start, and point to All Programs > Accessories > System Tools > Backup to start the wizard. 
	2. Click Next to skip past the opening page. Choose Backup files and settings from the second page, and then click Next. 
	3. Select which option you Want to back up.
	4. Click Next and in the Backup Type, Destination, and Name page, specify a back up location using the Browse button.
	5. Find and select the drive that specifies your N299 as your backup destination and click Next.
	6. Click Next to display the wizard’s final page and click Finish to start backing up. 
	Apple OS X Backup Utilities

	Mac OS X does not include any backup software. However, there are a number of backup solutions available for the Mac OS X, including: iBackup, Psyncx, iMSafe, Rsyncx, Folder Synchronizer X, Tri-BACKUP, Impression, Intego Personal Backup, SilverKeeper, and Apple's dotMac Backup utility to name just a few. To find even more freeware and shareware backup utilities to choose from, go to VersionTracker or MacUpdate and search on "backup".
	One-Button USB Copy

	The N299 can quickly backup data from USB devices with its One-Button USB Copy function. To use this function, plug a USB storage device to the N299’s front USB port. Then, simply press the One-Touch USB Copy button on the front panel, and all of the contents of the USB storage device will be copied over to the N299. 
	All of the files copied will be contained in the USBCopy service folder, under a subfolder names with a timestamp (YearMonthDayHHMM). For more on the N299’s service folders, check out Chapter 3: System Management > Storage Management > Service Folders.
	Chapter 6: Tips and Tricks
	Mapping a Client PC to the N299

	You can map share folders on the N299 so that you can access them as if they were drives on your computer. You can connect to the shared network folders on the N299 as follows: 
	Windows

	1. Go to the My Computer folder in Windows. 
	2. In the menu bar, select Tools and then Map Network Drive…
	3. The Map Network Drive window appears.
	4. Assign a drive letter for the share folder.  
	5. Click the Browse button to find the folder over your network. Alternatively, you may enter the folder name you wish to connect to or enter its IP address. (i.e. \\192.168.1.100\share)
	6. Click Finish. When the Connect As… window appears, enter a user name and password.
	7. Click OK. The share folder appears as the drive you assigned. You can now access this folder as though it were a drive on your computer.
	Apple OS X

	On an Apple computer, you can connect to shared computers and servers using a network address. 
	1. Choose Go > Connect to Server…
	2. Enter the network address for the server in the Server Address text box.
	When connecting using SMB/CIFS protocol, type:
	smb://192.168.1.100/Folder1
	When connecting using AFP protocol, type:
	afp://192.168.1.100/Folder1
	Click Connect.
	3. When MAC OS X is trying to connect N299, it will ask for a User Name and Password which has access to the folder. 
	4. When MAC OS X has connected to the N299 successfully, an icon representing the folder will appear on the MAC OS X desktop. You can access the folder by double clicking on the icon. 
	USB Storage Expansion

	The N299 supports external USB hard disks through its two USB ports. Once a USB hard disk has been successfully mounted, users can access the files on the USB hard disk under the USBHDD folder. The N299 supports up to 6 USB external storage devices. All file names on the USB disk volume are case sensitive.
	Before attaching a USB disk drive to N299, you have to partition and format it on a desktop computer or a notebook first. The attached device will be located at \\192.168.1.100\usbhdd\usb1\1\ where 192.168.1.100 means the IP address of N299, usb1 stands for the first USB device, and 1 stands for the first partition on disk #1, the USB disk drive. If it is an NTFS partition, NAS users can open or copy files from \\192.168.1.100\usbhdd\usb1\1 but cannot add new files or modify existing files. 
	Replacing Damaged Hard Drives

	If you are using RAID 1, you can easily replace a damaged hard drive in the Thecus N299 while keeping your data secure with the system’s automatic data recovery. 
	Hard Drive Damage

	When a hard drive is damaged, its LED glows a steady red. If there is data in the RAID volume, the system LED also glows red and the system beeps.
	Replacing a Hard Drive 

	To replace a hard disk drive in the N299:
	1. Remove two screws located on the back of the unit using a Philips screwdriver. 
	2. Unscrew four mounting screws.
	3. Lift up the hard disk tray by pulling up the top panel of the N299.
	4. Remove the damaged hard drive.
	5. Carefully insert a standard 3.5” SATA hard disk into the tray, and secure the hard disk with screws from the included accessory pack.
	6. Carefully lower the hard disk tray back into the N299. 
	7. After making sure the tray is in place and the connectors are aligned, secure the hard disk tray with screws. 
	RAID Auto-Rebuild

	When using RAID 1 on the N299, you can use the auto-rebuild function when an error is detected. 
	1. When a hard disk fails the system beeps and/or an email notification is sent to specified receivers.
	2. Check the hard disk LEDs to see which disk has failed.
	3. Follow the steps mentioned above to replace the failed hard disk.
	4. The system automatically recognizes the new hard disk and starts the auto-rebuild sequence to resume its status before the hard disk crash.
	Remote Administration

	You can set up your N299 for remote administration. With remote administration, you can access your N299 over the Internet, even if your N299 is behind a router. This is especially useful if you are traveling and suddenly need a file from your N299. 
	Setting up remote administration is a three-part process, and will require the following equipment:
	 Thecus N299 NAS device
	 Cable/DSL Router with Dynamic DNS support
	 Home PC
	Internet Connection
	Part I - Setup a DynDNS Account

	1. Go to http://www.dyndns.org from your home PC.
	2. Click on the Sign Up Now link.
	3. Check the Check boxes, select a user name (i.e.: N299), enter your email address (i.e.: xxx@example.com), check Enable Wildcard, and create a password (i.e.: xxxx).
	4. Wait for an email from www.dyndns.org.
	5. Open the email and click on the link to activate your account
	Part II - Enable DDNS on the Router

	1. Go to the router setup screen and select IP Config > Miscellaneous DDNS Setting from your Home PC.
	2. Click on Yes for Enable the DDNS Client?
	3. Select www.dyndns.org.
	4. Go to router setup screen, and enter the following information:
	a. User Name or E-mail Address: xxx@example.com
	b. Password or DDNS Key: xxxx
	c. Host Name: www.N299.dyndns.org
	d. Enable wildcard? Select Yes
	e. Update Manually: Click Update
	Part III - Setting up Virtual Servers (HTTPS)

	1. Navigate to NAT Setting > Virtual Server.
	2. For Enable Virtual Server?, select Yes
	3. Setup the HTTPS Server
	a. Well-Known Applications: Select User Defined
	b. Local IP: Enter 192.168.1.100
	c. Port Range: 443 (the default HTTPS port setting on the N299)
	d. Protocol: select TCP
	e. Click Add.
	f. Click Apply.
	4. Test the HTTPS connection from another computer on the Internet
	a. From a remote computer, open your browser and enter https://www.N299.dyndns.org
	b. You should see the login page of N299.
	Firewall Software Configuration

	If you are using a software firewall (i.e. Norton Internet Security) and are having trouble connecting to the N299, you can try the following steps:
	1. Double click the NIS icon on system tray, and then configure the Personal Firewall.
	2. On the Programs page, find the SetupWizard.exe and change its permission to "Permit All". If it's not in the program list, use the Add or Program Scan buttons to find it.
	3. On the Networking page, manually add N299 IP address (i.e. 192.168.1.100) to the Trusted list. 
	Chapter 7: Troubleshooting Guide
	N299 Won't Turn On

	In the event that the N299 won’t turn on, check to see that the power cable is correctly plugged in to the N299. Also check to see if the electrical outlet is functioning. 
	Resetting NAS IP Address and Admin Password

	If you’ve forgotten the admin password, or if you need to reset the unit’s IP address, first make sure that the unit is powered off. press the reset button and the power button at the same time. keep pressing the reset button for 15 seconds then release it. When you hear the beep sound, the rebooting process is completed. After that, the N299's WAN IP address will be reset to 192.168.1.100 temporarily. Please note that all file services at this time will be stopped.
	1. When you point your browser to 192.168.1.100, you will see the following screen.
	2. If you select Reset to Factory Default option, the system will be reset. Below are the default system settings:
	Admin password (admin
	WAN IP address ( 192.168.1.100
	WAN IP Gateway ( 192.168.1.1
	WAN Jumbo Frame Support ( Off
	LAN IP ( 192.168.2.254
	LAN Jumbo Frame Support ( Off
	HTTP Port ( 80 
	HTTPS port ( 443
	Forgot My Network IP Address

	If you forget your network IP address and have no physical access to the system, you can use the setup wizard to retrieve the IP of your N299.
	1. Start the Setup Wizard, and it will automatically detect all Thecus IP storage products on your network.
	2. You should be able to find the IP address of the N299 which you have forgotten in the Device Discovery screen.
	Can't Access N299 from the LAN

	If you cannot access the N299 from the LAN, make sure that its network cable is correctly plugged in. Also, check to see if the N299’s WAN and LAN settings are configured correctly. 
	Can't Map a Network Drive in Windows XP

	You may have problems mapping a network drive under the following conditions:
	1. The network folder is currently mapped using a different user name and password. To connect using a different user name and password, first disconnect any existing mappings to this network share.
	2. The mapped network drive could not be created because the following error has occurred: Multiple connections to a server or shared resource by the same user, using more than one user name, are not allowed. Disconnect all previous connections to the server or shared resource and try again.
	To check out existing network connections, type net use under the DOS prompt. 
	N299 Chassis Feels Hot

	The N299 uses its chassis to dissipate heat, and feeling warm to the touch is completely normal. As such, make sure that the N299 is left in a well-ventilated area to avoid overheating the unit.
	Can’t Find Printer Server / Media Server / Download Manager 

	To use these functions, you must first install their respective modules. Once installed, these will appear on the Main Menu. For installation instructions, refer to the sections below:
	Chapter 4: Additional Feature Setup> Media Server Module Installation
	Chapter 4: Additional Feature Setup> Download Manager Module Installation
	Chapter 4: Additional Feature Setup> Printer Server Module Installation
	Restoring Factory Defaults

	From the System menu, choose the Factory Default item and the Reset to Factory Default screen appears. Press Apply to reset the N299 to factory default settings.
	Problems with Time and Date Settings

	The administrator is able to select an NTP Server to keep the N299’s time synchronized. However, if the N299 can not access the Internet, you may encounter a problem when setting the Time and Time Zone. If this happens:
	1. Login to the Web Administration Interface.
	2. Navigate to System > Time.
	3. Under NTP Server, select No.
	4. Set the Date, Time, and Time Zone.
	5. Click Apply.
	In addition, if the N299 is able to access the Internet and you want to keep the NTP Server clock.isc.org by default, please make sure the DNS Server is correctly, thereby allowing the NTP Server name to correctly resolve. (See Network > LAN 1 > DNS Server)
	Simple Problem Diagnosis Procedure

	This procedure is meant to provide a simple and quick way to identify which part of the N299 has failed.
	1. Don’t insert a hard disk into the N299. Attach the power cord and then reset the IP address and admin password to the default settings by doing the following:
	a) Power on the N299 and immediately press the Reset button for 10 seconds. (The Reset button is near the LAN connector)
	b) This resets the N299 to its default IP address and password settings.
	 Default IP: 192.168.1.100
	 Default admin password: admin
	2. Attach the power cord and connect the LAN cable between the N299 and a PC. Don’t use a hub.
	3. Turn on the N299 and check the front panel. The Power LED should glow blue after power button is pressed. Then, the Busy LED starts blinking orange for around 60 seconds. After that, the Busy LED turns off. If the Busy LED keeps blinking orange for more than 3 minutes, the firmware may be corrupted during improper firmware upgrade procedures. It means that the motherboard has malfunctioned and needs to be repaired.
	4. Set the IP address of the PC as 192.168.1.111, and then access the Login page. Make sure the N299 and the PC is directly connected through a LAN cable, and not through a hub or a router.
	5. Check if the Web Administration Interface shows up and works fine. Then, check if the system status is normal and the HDD Power LED works fine. If the results are positive, it means that the N299 is functioning normally. Otherwise, the N299 may be damaged.
	6. Suppose that the N299 has been damaged. If the Power LED glows blue and both system and power fans work fine after power button pressed, the motherboard needs to be checked and repaired. Otherwise, the power supply unit has problems.
	Appendix A: Product Specifications
	Hardware Specifications
	Software Specifications

	** For supported USB dongles, please contact sales@thecus.com
	Appendix B: Customer Support
	If your N299 is not working properly, we encourage you to check out Chapter 7: Troubleshooting Guide, located in this manual. You can also try to ensure that you are using the latest firmware version for your N299. Thecus is committed to providing free firmware upgrades to our customers. Our newest firmware is available on our Download Center:
	http://www.thecus.com/download.php
	If you are still experiencing problems with your N299, or require a Return Merchandise Authorization (RMA), feel free to contact technical support via our Technical Support Website:
	http://www.thecus.com/support_tech.php
	Customers in the US should send all technical support enquiries to this email address:
	support-us@thecus.com
	If you would rather receive support over the phone, you can contact Thecus FAE Support at:
	+886-2-26981788
	Please note that our headquarters are in Taipei, Taiwan, and our office hours are Monday to Friday, 9:00 to 17:00.
	For Sales Information you can e-mail us at:
	sales@thecus.com
	Thank you for choosing Thecus!
	Appendix C: RAID Basics
	Overview

	A Redundant Array of Independent Disks (RAID) is an array of several hard disks that provide data security and high performance. A RAID system accesses several hard disks simultaneously, which improves I/O performance over a single hard disk. Data security is enhanced by a RAID, since data loss due to a hard disk failure is minimized by regenerating redundant data from the other RAID hard disks.
	Benefits

	RAID improves I/O performance, and increases data security through fault tolerance and redundant data storage.
	Improved Performance

	RAID provides access to several hard disk drives simultaneously, which greatly increases I/O performance.
	Data Security

	Hard disk drive failure unfortunately is a common occurrence. A RAID helps prevent against the loss of data due to hard disk failure. A RAID offers additional hard disk drives that can avert data loss from a hard disk drive failure. If a hard drive fails, the RAID volume can regenerate data from the data and parity stored on its other hard disk drives.
	RAID Levels

	The Thecus N299 supports standard RAID levels 0, 1, and JBOD. You choose a RAID level when you create a system volume. The factors for selecting a RAID level are:
	 Your requirements for performance
	 Your need for data security
	 Number of hard disk drives in the system, capacity of hard disk drives in the system
	The following is a description of each RAID level:
	RAID 0

	RAID 0 is best suited for applications that need high bandwidth but do not require a high level of data security. The RAID 0 level provides the best performance of all the RAID levels, but it does not provide data redundancy. 
	RAID 0 uses disk striping and breaking up data into blocks to write across all hard drives in the volume. The system can then use multiple hard drives for faster read and write. The stripe size parameter that was set when the RAID was created determines the size of each block. No parity calculations complicate the write operation. 
	RAID 1

	RAID 1 mirrors all data from one hard disk drive to a second one hard disk drive, thus providing complete data redundancy. However, the cost of data storage capacity is doubled. 
	This is excellent for complete data security.
	JBOD

	Although a concatenation of disks (also called JBOD, or "Just a Bunch of Disks") is not one of the numbered RAID levels, it is a popular method for combining multiple physical disk drives into a single virtual one. As the name implies, disks are merely concatenated together, end to beginning, so they appear to be a single large disk.
	As the data on JBOD is not protected, one drive failure could result total data loss.
	Stripe Size

	The length of the data segments being written across multiple hard disks. Data is written in stripes across the multiple hard disks of a RAID. Since multiple disks are accessed at the same time, disk striping enhances performance. The stripes can vary in size.  
	Disk Usage

	When all 4 disks are of the same size, and used in RAID, the N299’s disk usage percentage is listed below:
	Overview

	This product included copyrighted third-party software licensed under the terms of GNU General Public License. Please see THE GNU General Public License for extra terms and conditions of this license.
	Source Code Availability

	Thecus Technology Corp. has exposed the full source code of the GPL licensed software. For more information on how you can obtain our source code, please visit our web site, http://www.thecus.com.
	Copyrights 
	 This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
	 This product includes software developed by Mark Murray.
	 This product includes software developed by Eric Young (eay@cryptsoft.com).
	 This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/).
	 This product includes PHP, freely available from (http://www.php.net/).
	 This product includes software developed by the University of California, Berkeley and its contributors.
	 This product includes software developed by Winning Strategies, Inc.
	 This product includes software developed by the Apache Group for use in the Apache HTTP server project (http://www.apache.org/).
	 This product includes software developed by Softweyr LLC, the University of California, Berkeley, and its contributors.
	 This product includes software developed by Bodo Moeller.
	 This product includes software developed by Greg Roelofs and contributors for the book, "PNG: The Definitive Guide," published by O'Reilly and Associates.
	 This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
	 This product includes software developed by Yen Yen Lim and North Dakota State University.
	 This product includes software developed by the Computer Systems Engineering Group at Lawrence Berkeley Laboratory.
	 This product includes software developed by the Kungliga Tekniska Högskolan and its contributors.
	 This product includes software developed by the Nick Simicich.
	 This product includes software written by Tim Hudson (tjh@cryptsoft.com).
	 This product includes software developed by Christopher G. Demetriou for the NetBSD Project.
	CGIC License Terms

	Basic License
	CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Thomas Boutell and Boutell.Com, Inc.
	Permission is granted to use CGIC in any application, commercial or noncommercial, at no cost. HOWEVER, this copyright paragraph must appear on a "credits" page accessible in the public online and offline documentation of the program. Modified versions of the CGIC library should not be distributed without the attachment of a clear statement regarding the author of the modifications, and this notice may in no case be removed. Modifications may also be submitted to the author for inclusion in the main CGIC distribution.
	GNU General Public License

	Version 2, June 1991
	Copyright © 1989, 1991 Free Software Foundation, Inc.
	51 Franklin St, Fifth Floor, Boston, MA  02110-1301 USA
	Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
	PREAMBLE
	The licenses for most software are designed to take away your freedom to share and change it.  By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.  This General Public License applies to most of the Free Software Foundation's software and to any other program whose authors commit to using it.  (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.)  You can apply it to your programs, too.
	When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you Want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.
	To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.
	For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code.  And you must show them these terms so they know their rights.
	We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.
	Also, for each author's protection and ours, we Want to make certain that everyone understands that there is no warranty for this free software.  If the software is modified by someone else and passed on, we Want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.
	Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary.  To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.
	The precise terms and conditions for copying, distribution and modification follow.
	TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
	0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License.  The "Program", below, refers to any such program or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language.  (Hereinafter, translation is included without limitation in the term "modification".)  Each licensee is addressed as "you".
	Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.  The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program).
	Whether that is true depends on what the Program does.
	1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.
	You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.
	2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:
	a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.
	b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
	c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License.  (Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)
	These requirements apply to the modified work as a whole.  If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works.  But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.
	Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.
	In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.
	3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
	a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
	b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
	c) Accompany it with the information you received as to the offer to distribute corresponding source code.  (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)
	The source code for a work means the preferred form of the work for making modifications to it.  For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable.  However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.
	If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.
	4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.  Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.
	5. You are not required to accept this License, since you have not signed it.  However, nothing else grants you permission to modify or distribute the Program or its derivative works.  These actions are prohibited by law if you do not accept this License.  Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.
	6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions.  You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.
	7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License.  If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all.  For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.
	If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.
	It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices.  Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.
	This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
	8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded.  In such case, this License incorporates the limitation as if written in the body of this License.
	9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time.  Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
	Each version is given a distinguishing version number.  If the Program specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation.  If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.
	10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission.  For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this.  Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.
	NO WARRANTY
	11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
	12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
	END OF TERMS AND CONDITIONS

